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Starting the IE-33

Stylus - Press to release

1. Insert the iPAQ into the IE-33J
jacket and plug the IE-33M
microphone into the IE-33J

2. Press power button
to turn on IE-33
3. Using the stylus tap on
"Start"
4. Using the stylus tap
on "IE-33"
5. Wait while the program
starts and memories are
loaded
6. The screen of the last
used function will
appear
7. Tap the "Function"
menu and choose the
desired function

RTA

RTA/LED

SPL Monitor

Seat to Seat

Strip Chart

Polarity

Oscilloscope

Signal Generator

RTA Controls
Tap the "Display" menu and then
"Set dB Scale" to bring up the
dB/Center, dB division window

dB/division display

Max Resolution
240 points

60 - 1/6 Octave
bands

Memory Snapshot /Average
Sample button (See"Averaging"
& Memory sections of the manual)
dB/Center display
Store/Recall Memories
Average display On/Off
RTA display On/Off
Weighting - A,C, Flat

dB Center UP/Down
(In increments set by dB/Div)

Frequency Select
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dB SPL display
Averaging Controls
Tap on screen or use the
mechanical buttons to set
dB/division

Start/Stop RTA

(Used in memory recall)

10 - 1 Octave
bands

Tap to Enter or Display the
Preferred Curve. Use Joystick
to enter values: dB & Frequency

Peak Hold

Once the RTA display is stopped
use the Joystick to select and
read dB levels of individual
frequency bands.

SPL Response - Fast,
Slow, Peak, Impulse
30 - 1/3 Octave
bands

Preferred Curve Set/Display

NR

Turns On/Off
Weighting applied
to the RTA screen.
Note: Freq Detect
is only
accessable from
the Max Res
screen.

Freq Detect

NC

Pushing the center of the
Joystick performs the same
function as Start/Stop RTA
Ivie Technologies, Inc Rev. November, 2005
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IE-33 Quick Start

Step 1 - Insert the iPAQ into the IE-33J jacket
and plug the IE-33M microphone into
the IE-33J.

Step 2 - Press power button to
turn on IE-33.

Stylus - press to release.

Step 3 - Using the stylus tap
on "Start."
Step 4 -

Using the stylus tap
on "IE-33."

Step 5 - Wait while the program
starts and memories are
loaded.
Step 6 - The screen of the last
used function will
appear.

Step 7 - Tap the "Function" menu
and choose the desired
function.
Step 8 - Start using the IE-33.
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Starting the IE-35

Signal Generator
/Earphone output

1. Insert the Axim into the IviePAL
jacket and plug in the IE-35M
microphone

Stylus

2. Press power button
to turn on IE-35
3. Using the stylus tap on
"Start"
4. Using the stylus tap
on "IE-36"
5. Wait while the program
starts and memories are
loaded
6. The screen of the last
used function will
appear
7. Tap the "Function"
menu and choose the
desired function

RTA

SPL Monitor

Seat to Seat

Strip Chart

Polarity

Oscilloscope

Signal Generator

Voltmeter

RT60 (Optional)

RTA Controls
dB/division display

Tap the "Display" menu and then
"Set dB Scale" to bring up the
dB/Center, dB division window
Preferred Curve Set/Display

Max Resolution
240 points

60 - 1/6 Octave
bands

dB/Center display
Store/Recall Memories
Average display On/Off
RTA display On/Off
Weighting - A,C, Flat

dB SPL display
Averaging Controls
Use the mechanical
buttons to set
dB/division

Start/Stop RTA
Peak Hold

Once the RTA display is stopped
use the Joystick to select and
read dB levels of individual
frequency bands.

SPL Response - Fast,
Slow, Peak, Impulse
30 - 1/3 Octave
bands

Tap to Enter or Display the
Preferred Curve. Use Joystick
to enter values: dB & Frequency

dB Center UP/Down
(In increments set by dB/Div)

Freq Detect
Turns On/Off
Weighting
applied to
the RTA
screen.

NR

NC

Frequency Select
(Used in memory recall)

10 - 1 Octave
bands
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Pushing the center of the
Joystick performs the same
function as Start/Stop RTA
Ivie Technologies, Inc Rev. Nov1, 2005

Memory #3 being displayed

Step 1 - Tap
on the yellow
"Subtract"
control.

Subtract / Display Two Memories

Step 2 - Select two
sources or
spectrums for
comparison:
Scratch Memory,
Preferred Curve,
Step 3 - The result will be displayed in
RTA Display or
dB Average and then yellow on the screen. To exit this mode, tap
on "Subtract" and then "CANCEL."
Freq Tap "S1 - S2."

Step 1 - Tap on "Display" then "Memory
Cursor."
Step 2 - Tap on "Stop."
Step 3 - Turn RTA display On/Off as desired.
Step 4- Use Left/Right Cursor to select the
frequency.

Memory Cursor

From this screen you can "Store" a Scratch memory to
Re-name a memory
main memory or "Load" a memory from main back into
from "Scratch" to a more
a Scratch memory. Preferred, Peak and Subtraction
descriptive name and
memories can also be "Stored" and "Loaded."
tap on "OK."

Tap on a memory file to
move it into a Scratch
memory so it can
displayed.

Red "PE" Preferred curve not stored.
Blue = Scratch memory #3 displayed.
Red "A"= No Average curve is stored.
Green "R" = RTA curve is displayed.

Red colored 6, 7, 8 & 9 = These
Scratch memories are empty and
available for curve storage.

Buff colored 1, 2, 4 & 5 = Curves are
stored in these memories but they are
not currently being displayed.

Step 2 - To store a Scratch memory to the
main memory, tap on the "Memory" control to
bring up the memory management screen.

Tap the Blue Scratch memory to
remove the stored curve from the
display. The background color will
turn to Buff indicating that the
memory is filled but not presently
displayed.

Step 1 - Tap an empty Scratch
memory location 1 - 9 (colored in
Red). The curve will appear on the
screen and the Scratch memory
background color will turn Blue
indicating it is now filled and being
displayed.

Store a curve to memory

The IE-33 offers powerful Memory Management functions (see manual for details).
Basically, there are nine Scratch Memories, an Average memory and a Preferred Curve
memory available via on-screen controls, but spectra captured in these temporary
Scratch Memory slots can be renamed and stored in virtually unlimited number.

RTA Memories
RTA Averaging Functions

Green = Display On

With Average
curve displayed,
press an empty
(red color) Scratch
Memory to store.

Green = Disp On

Buff = Disp Off

Average Curve

Real time "R" display Off
Average "A" display turned on.

Tap "Clear" to Clear the Average curve and reset the Count to zero.
Tap "Count" to Exit the Average mode.

Real time "R" and Average
"A" displays turned on.

To Select Averaging Method
1 - Tap "File."
2 - Tap "Preferences."
3 - Tap either "Power Average."
or "Arithmetic Average."

Step 4 - Store the Average curve by selecting any un-used scratch
memory. If you wish to store the real-time curve instead of the Average
curve, turn off the Average curve display before pressing the Scratch
Memory Store control.

Step 3 - The "Average" display will be replaced with a "Count=X" display,
with X= the number of samples taken. In the Trigger mode the Count will
be incremented with each tap of the "Add" control. In the Continuous
mode the Count will be controlled by the "Pause/Resume" control.

Step 2 - Tap on the "Average-P"
control to enter into Average mode.

The Trigger mode will take only one
sample each time the "Add" control is
pressed or the Thumb button on the
side of the IE-33 is pressed.

The Continuous mode will
automatically take sample after
sample until the "Pause/Resume"
control is pressed.

Step 1 - Select either the Continuous
(Cont.) or Trigger mode for
Averaging.

The various averaging functions of the IE-33 constitute one of the most powerful
feature sets in the instrument. Spatial averaging is made easier (you don't have to
average one memory with another). Averaging samples can be automatically or
manually collected. The user can select Arithmetic or Power averages. See the
manual for a complete outline of the IE-33's powerful averaging features.
Continuous Mode
Tigger Mode

Ivie IE-33 & IE-35 Manual
IE-35 Quick Start
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Introduction
Congratulations! With your purchase of the Ivie IE-33, or IE-35, you not only have one of the most powerful, versatile, and accurate audio spectrum analyzers available, but you also have an analysis system that is capable of
expanding as your needs expand. The supplied microphone is a Type II microphone, making the standard IE-33,
or IE-35, a Type II measurement system. For those needing Type I accuracy, an optional microphone, preamplifier and extension cable is available to convert either analyzer to a Type I measurement system. With reasonable care, the IE-33 and IE-35 will provide a long period of useful service.
This manual is intended to familiarize you with the basic operations of the IE-33 and IE-35, and to whet your
appetite concerning some of its possibilities. It is in no way intended to be the total description of all the possibilities of these units.
The IE-33 software runs on the HP© iPAQ© and requires an iPAQ 3950, or later jacket compatible model. (See
the IE-33 FAQ at www.ivie.com for a complete list of compatible iPAQ models). Pocket PC 2003 OS is required
and ActiveSync software Version 3.7.1 or later. The IE-35 software runs on the Dell® Axim® X50 or later model.
(The IE-35 is shipped with the Dell® Axim® X51v). Pocket PC 2005 is required and ActiveSync software Version
4.0, or later.

*******NOTICE!! IE-33 POTENTIAL DATA LOSS!!*******
The iPAQ, like all PDA’s runs on battery power. HP® is clear in their warnings about data loss if the battery is
completely run down. If you run the battery all the way down, your data can and will be lost! (This has a much
harsher sound if you’ve just completed a couple of days of taking measurements when the data goes bye bye!).
To guard against accidental data loss, a backup utility is included in the iPAQ software suite. This utility is easy
to use. You can schedule regular (even daily) backups that will happen automatically, or you can start backups
manually. The Sprite Backup utility included with the iPAQ will back up to the “iPAQ File Store” (an 8 MB non
volatile storage area in the iPAQ itself), or to an SD-style memory card that plugs into the iPAQ’s SD card slot.
Sprite also makes a separate backup utility which can be used to back up your iPAQ to the hard drive of your
PC. We recommend that you make provision for backing up your IE-33 data on a regular basis.
The IE-35 does not have this concern. It is based on the Dell® Axim® X51v which features “Retentive
Memory.” The IE-35 will not lose data, even if the battery is accidentally run down.

IE-33 Controls (IE-35 Controls are Further Detailed on Pages 8 & 9)
As demonstrated across the page, the IE-33 makes use of a number of different controls, both software and
hardware based. The controls can be divided into three categories: 1) Hardware Buttons, 2) Software Defined
Stylus Buttons and 3) Pop-up Menus. Like the stylus buttons, the pop-up menus are activated using the stylus.

Hardware Buttons (IE-33)
The IE-33 software defines the use of the iPAQ hardware buttons as shown across the page. The thumb button,
for example, can be used to take a memory "snapshot" when in the RTA mode. It is also used to pause or
resume taking samples when in the Average Continuous mode and to "add a single sample" when in the Memory
Trigger mode. These features are covered in detail in the section of this manual dealing with memory functions.

Stylus Buttons (IE-33)
The stylus buttons contain many of the most used features of the IE-33. They are clearly labeled and very intuitive. Some duplicate the function of hardware buttons, as in the Zoom In and Zoom Out functions, as shown in
the illustration on page 3. The stylus buttons allow selection of the RTA display in octave, one third octave,
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IE-33M - Microphone.
SD Memory expansion slot.
Audio Output Jack on Ipaq 3900
series(3.5mm stereo) - Can be used as
headphone jack or as output for the Signal
Generator.

Microphone level input.
Channel 1 Line level input.

IE-33J - Jacket Shown with
optional extended battery pack.

Channel 2 Line level input.

iPAQ - Power On/OFF.

Audio Output Jack on Ipaq 5500
series(3.5mm stereo) - Can be used as
headphone jack or as output for the Signal
Generator.

Charging indicator - Flashes
while charging, on full-time when
charging completed.
Speaker.
Stylus - Push to release.

Thumb Button - Instant Memory
Snapshot. During Average controls
"Pause/Resume" in continuous
mode and "Add" in Trigger mode.

Sound Pressure Level and
Weighting display.
Status Window Red = Function Stopped by user.
Green = Function Running.

Software defined buttons.

Options

Joystick - Up/Down - dB.
Range, dB Level.
Joystick - Left/Right - Frequency selection.
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one sixth octave or maximum resolution. The Decay stylus button adjusts the display averaging time.
Successively tapping it rotates from Decay 1, to Decay 2, to Decay 3 and back to Decay 1 again. Many of the
averaging functions and the memory functions are controlled by the stylus buttons.

Pop-Up Menus (IE-33)
The pop-up menus add tremendous flexibility to the IE-33. Tapping the "Function" pop-up menu, for example,
allows you to select one of the many functions of the IE-33. Choices include RTA, RTA with an LED display
appearance, SPL Monitor, Seat to Seat (SPL variation), Strip Chart function, Polarity measurement, Oscilloscope
function, Signal Generator, Volt Meter and RT-60, if the RT-60 software module has been purchased..
The "Options" pop-up menu allows the setting of display scale (Set dB Scale), provides for RTA display weighting, allows the display of Peak Hold on the RTA screen, and provides for the selection of NC and NR measurements. Entering a "Preferred Curve" is possible as well as activating Audio Feed Through to the iPAQ audio
output. It is possible to Play a Test Wave file, or continuously loop through a wave file (Play Test Loop). The
menu items in the “Options” pop-up menu are interactive with the “Function” pop-up menu. As different functions are selected, different options for the selected function will appear in the “Options” pop-up menu.

IE-35 Controls
As demonstrated across the page, the IE-35 makes use of a number of different controls, both software and
hardware based. The controls can be divided into three categories: 1) Hardware Buttons, 2) Software Defined
Stylus Buttons and 3) Pop-up Menus. Like the stylus buttons, the pop-up menus are activated using the stylus.

Hardware Buttons (IE-35)
The IE-35 software defines the use of the Axim hardware buttons as shown across the page. The lower thumb
button, for example, can be used to take a memory "snapshot" when in the RTA mode. It can also pause or
resume taking samples in the Average Continuous mode and can "add a single sample" when in the Memory
Trigger mode. These features are covered in detail in the section of this manual dealing with memory functions.

Stylus Buttons (IE-35)
The stylus buttons contain many of the most used features of the IE-35. They are clearly labeled and very intuitive. Some duplicate the function of hardware buttons, as in the Zoom In and Zoom Out functions, as shown in
the illustration on page 5. The stylus buttons allow selection of the RTA display in octave, one third octave,
one sixth octave or maximum resolution. The Decay stylus button adjusts the display averaging time.
Successively tapping rotates it from Decay 1, to Decay 2, to Decay 3 and back to Decay 1 again. Many of the
averaging functions and the memory functions are controlled by the stylus buttons.

Pop-Up Menus (IE-35)
The pop-up menus add tremendous flexibility to the IE-35. Tapping the "Function" pop-up menu, for example,
allows you to select one of the many functions of the IE-35. Choices include RTA, RTA with an LED display
appearance, SPL Monitor, Seat to Seat (SPL variation), Strip Chart function, Polarity measurement, Oscilloscope
function, Signal Generator, Volt Meter and RT-60, if the RT-60 software module has been purchased..
The "Options" pop-up menu allows the setting of display scale (Set dB Scale), provides for RTA display weighting, allows the display of Peak Hold on the RTA screen, and provides for the selection of NC and NR measurements. Entering a "Preferred Curve" is possible as well as activating Audio Feed Through to the Axim audio output. It is possible to Play a Test Wave file, or continuously loop through a wave file (Play Test Loop).
The menu items in the “Options” pop-up menu are interactive with the “Function” pop-up menu. As different
functions are selected, different options for the selected function will appear in the “Options” pop-up menu.
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Microphone level input
Switchcraft QG TA4 series.

IE-35M - Microphone.

SD and CF card memory expansion
slots. The CF slot is used by the
IviePAL to send data to the Dell Axim.
The SD card is available for use, and
is accessable when the Axim is
removed from the IviePAL.

Stylus - Pull up to access.

Channel 2 Line level input
RCA connector.
Channel 1 Line level input
RCA connector.

Wireless Indicator - Flashes
Green when WiFi is in use.
Flashes Blue when Bluetooth is
in use.

Audio Output Jack - 3.5mm
stereo - Can be used as
headphone jack or as output
for the Signal Generator.
Power On/OFF
Charging indicator - On/Off
power button is illuminated
Orange while charging and
Green when the charge is
completed.

IviePAL Jacket

Sound Pressure Level
and Weighting display.

Software defined buttons.
Status Window Red = Function Stopped by user.
Green = Function Running.

Speaker- Surrounds
the joystick button.

To remove the Dell Axim from
the IviePAL, depress the latch
located on the end of the
IviePAL and slide the Axim
down and out of the IviePAL.

Up/Down - dB.
Range, dB Level.

Slide straight away from
CF connector

Joystick - Left/Right Frequency selection.
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Getting Started with Your IE-33 or IE-35
Important Note: The IE-33 and IE-35 have identical feature sets and identical software “look and
feel.” There are some appearance enhancements with the VGA graphics of the IE-35, but the software
screens are functionally identical. While most of the illustrations in this manual show the IE-33, the
IE-35 operation is identical, except where noted.
If you purchased the IE-33 or IE-35 complete, you will not need to install the software in the iPAQ or Axim, or
calibrate the microphone to the unit. If you purchased just the IE-33J Jacket, or IE-35 PAL, you will need to do
some preliminary work before you can begin using your analyzer. If you are already familiar with installing software on a PDA, the following information will simply confirm what you already know.

IE-33J Jacket & IE-35 PAL: Data and Program Transfer
If you have purchased the IE-33J (jacket without iPAQ ), or the IE-35 PAL (jacket without Axim) you will need to
install the analyzer software on your PDA in order to use the unit and make measurements. Even if you have a
complete IE-33 or IE-35 package, you will have need to install software upgrades and updates as they become
available. Also, after measurement sessions, you may wish to bring your data files across from the analyzer to
your PC for printing or further data manipulation.
All data and program transfers between the PDA and your PC are done using Microsoft's ActiveSync software
(Version 3.7.1 for the IE-33 and Version 4.0 or later for the IE-35). ActiveSync is provided on the standard PDA
CD that accompanies your iPAQ or Axim. Follow the instructions provided with your unit to install the
ActiveSync software and create a "partnership" between your PDA and your PC. ActiveSync is also available
directly from Microsoft’s web site. Questions about the ActiveSync communication between a PDA and PC are
supported by PDA Manufacturer. If you have problems setting up ActiveSync, contact Technical Support for HP
or Dell.
For further information on this subject, refer to Appendix III of this manual titled " Data and Program Transfer."

Beginning to Use the IE-33 or IE-35
As shown in the illustrations across the page, firing up an IE-33 or IE-35 is simple. After sliding on the jacket
and making sure it is firmly seated, plug in the microphone. Turn on the unit using the power button by giving it
a quick press and release. Using the stylus, select IE-33 or IE-35 from the menu to begin running the software.
Next, select the function you wish to use and you're off and running.

Microphone Calibration
If you purchased the IE-33 or IE-35 complete, the microphone will have already been calibrated to the unit
before it left the factory. If you purchased the IE-33J Jacket, or the IE-35 PAL only to use with your own iPAQ or
Axim, you will need to calibrate the microphone. For the calibration procedure, consult Appendix II of this manual titled "IE-33 and IE-35 Mic Calibration."
The supplied microphone for the IE-33 is silver, while the microphone for the IE-35 is gold in color. However,
both microphones are Type II, electret microphones and are functionally identical and interchangeable.
Obviously, whenever a new or different microphone is used, your unit will need to be recalibrated. Both the
IE-33 and the IE-35 are capable of storing microphone calibrations for up to six different microphones. When a
different microphone is used, it’s stored calibration adjustment can simply be selected without having to go
through a calibration procedure all over again.
These instrumentation microphones are sensitive instruments and should be carefully handled to avoid damage.
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Getting Started

Step 1 - Insert the iPAQ into the IE-33J jacket
and plug the IE-33M microphone into
the IE-33J.

Step 2 - Press power button to
turn on IE-33.

Stylus - press to release.

Step 3 - Using the stylus tap
on "Start."
Step 4 -

Using the stylus tap
on "IE-33."

Step 5 - Wait while the program
starts and memories are
loaded.
Step 6 - The screen of the last
used function will
appear.

Step 7 - Tap the "Function" menu
and choose the desired
function.
Step 8 - Start using the IE-33.
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Real Time Analyzer Controls
Stylus Buttons: The IE-33 and IE-35 are several instruments in the same package: Real Time Analyzer,
Sound Level Meter, Signal Generator, Oscilloscope etc. One of their most powerful functions is Real Time
Analyzer (RTA). To make operation simple and intuitive, the most often used controls for the RTA are labeled
stylus buttons. The illustration across the page shows the stylus buttons associated with the RTA. Displays of
octave, third octave, sixth octave and maximum resolution (2048 FFT data points) are selectable as shown.
iPAQ and Axim Buttons: The IE-33 and IE-35 make use of the buttons found on the iPAQ and the Axim. Their
use is defined as shown across the page. The joy stick up/down function can be used to quickly adjust the display to bring the signal to the center of the screen. Either the stylus “Zoom In” and “Zoom Out” buttons, or the
push buttons to the right of the joy stick can be used to adjust screen resolution.
Pop-up Menus: Additionally, pop-up menus provide more features and selection capability. Tapping the
“Function” menu on the bottom of the screen with the stylus allows the selection of the RTA function. The various displays of the RTA function are shown in the illustration across the page. Below RTA in the Function menu
is “RTA LEDs.” Selecting this function will provide a display that looks like an LED bar graph that many are so
familiar with. The advantage of this display is that the screen resolution can be adjusted so each LED represents 1dB, 2dB or 3dB. These increments are very useful when equalizing a sound system.
To set the level at the center of the screen (dB Level) and to adjust the dynamic range of the screen (dB per
Division), tap the "Display" menu. Next, from the pop-up menu, select "Set dB Scale." The window shown on
the IE-33 at the bottom of the opposite page shows this feature (the IE-35 is identical). The other functions of
the pop-up menus are covered in detail in other sections of this manual.
Decay: Display speed (averaging time) is controlled by the stylus button titled “Decay.” Decay 1 is the fastest
response time available, with Decay 2 somewhat slower and Decay 3 being the slowest. Decay 3 is intended
for use with pink noise.
Start/Stop Stylus Button: This button stops (freezes) the RTA and SPL displays and starts them again when
tapped a second time.
RTA Display On/Off: The RTA display can be turned on or off using the stylus button illustrated across the
page. Green button indicates “On,” and brown button indicates “Off.”
Average Display On/Off: The Average display (when the Average function is active) can be turned on or off
using the stylus button. Green button indicates “On,” and brown button indicates “Off.” A red button indicates
the Average function is not active.
Memory Stylus Buttons: The IE-33 and IE-35 have 9 “scratch” memories (see the “Memory” section of this
manual for more information on memory and data storage). To store data in a scratch memory, tap the numbered stylus button. A “snapshot” will be stored. If you are in the Average mode, the average curve will be
stored. When a memory is empty, its stylus button is red. Memories with data in them have green stylus buttons when being displayed and brown when not being displayed. The last memory stored or activated for display always has a blue stylus button. Several memories can be displayed simultaneously and each will have its
own color on the display so it can be differentiated.
Preferred Curve: The last stylus button in the row of memory status buttons is the memory status button for
“Preferred Curve.” This is a very powerful function and its use is covered extensively in the section of this manual titled “RTA -Preferred Curve, Display Weighting, LED Display.”
SPL Readout Stylus Button: Tapping the SPL readout area will cause the analyzer to step through its electrical measurement modes. This is very useful for looking at voltage levels simultaneously with spectral content.
Obviously, this feature should be used when measuring electrical signal, not acoustic signals through the mic.
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Real Time Analyzer Controls

The RTA can display four different resolutions. The RTA samples at a rate of 44 kHz and
collects 2048 data points over a 20 Hz to 20 kHz bandwidth with each frame. When data is
stored, ALL 2048 data points are stored. This allows a recalled memory to be displayed in
any resolution desired by the user.

Tap to select desired
Resolution display

Options

Options

30 - 1/3 Octave
bands

Max Resolution
240 points

Options

Options

10 - 1 Octave bands

60 - 1/6 Octave bands

RTA Controls

Tap the "Options"
menu and then
"Set dB Scale"
to bring up the
dB/Center, dB division
window
Preferred Curve Set/Display
dB SPL display

dB/division display
Memory Snapshot /Average
Sample button (See"Averaging"
& Memory sections of the manual)
dB/Center display
Store/Recall Memories
Weighting - A,C, Flat
RTA display On/Off
Average display On/Off
Start/Stop RTA
SPL Response - Fast,
Slow, Peak, Impulse
Frequency Select
(Used in memory recall)

Options

Tap here to select dB
or Voltage readout
Averaging Controls
Tap on screen or use the
mechanical buttons to set
dB/division
dB Center UP/Down
(In increments set by dB/Div)

Options
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Preferred Curve Overlay
The Preferred Curve overlay is an IE-33 and IE-35 feature that allows the user to create a target overlay which
can be displayed on the screen. This can be a valuable aid to the equalization process. Users often use a target curve to contour the frequency response of a system to a desired result.
Creating a Preferred Curve: The preferred, or target curve, is nothing more than a line created by the user
that is overlaid on the screen to help visualize a desired result. To create a Preferred Curve, tap the PE memory
stylus button to the far right of the row of memory stylus buttons. The background on the PE button will change
to white, and the RTA display will move to a special 1/3 octave display with all bars touching the center reference line. Use the "joystick" rocker button to move the blue 1/3 octave bar right or left to a 1/3 octave you wish
to change. Use the joystick up/down to change the level of the 1/3 octave. Move to the next 1/3 octave and
change that level, and so on. You can create a roll-off target curve or other special spectra targets in this way.
Tap the Preferred Curve stylus button again and the background will turn green, the button text will change to
PT (preferred target), and the preferred target curve overlay will appear on-screen. Tap the button again and the
background will change to buff while the target curve is removed from the display. Tap the button again and it
changes to white as the Preferred Curve entry screen again appears so further editing, if desired, can be done.
Tap the button one more time and it turns green while the Preferred Curve is displayed.
Saving a Preferred Curve: The Preferred Curve you have created can be saved to the analyzer memory very
easily. You can save several Preferred Curves and call them back from memory as needed. To save a
Preferred Curve, tap the main screen Memory button, which will bring up the Memory Management screen.
Note that the default name of the Preferred Curve is "Preferred.ivi." Tap the "Store" button immediately to the
right of the file name and you will see a dialog box that allows you to change the name of the file to something
more descriptive (you can also change the file storage location if you wish). When finished editing, tap "OK" to
store the curve.
Loading a Preferred Curve from Memory: To load a previously stored Preferred Curve from memory, simply
tap the main screen Memory stylus button to bring up the Memory Management screen. Memory slot # 9 is
used for storing and recalling Preferred Curves. Tap the button labeled "Load" for the Preferred Curve memory
location and you will see a dialog that allows you to select the desired preferred curve. Tap "OK" and the curve
will be loaded into the Preferred Curve memory location. Both the IE-33 and IE-35 come with one pre-loaded
Preferred Curve, labeled "Preferred.ivi" that can be loaded into the display. It is a high end roll-off curve used as
a target for large venue sound system EQ.
LED Display: Many users are familiar with the LED display of Ivie's IE-30A analyzer. To have the IE-33 or
IE-35 emulate the IE-30's LED display, tap the "Function" pop-up menu at the bottom of the main screen and
choose "RTA LEDs." The RTA display changes to "LEDs.” Tip: The LED display can be useful in interpreting
amplitude information on the analyzer screen. By setting the dB scale to 5 dB/division each LED represents one
dB of amplitude. By setting 10 dB/division each LED represents 2 dB of amplitude, and by setting 15 dB/division, each LED represents 3 dB of amplitude change.
SPL Weighting and the RTA Display: Some users prefer to see the normal weighting filters that are applied to
SPL measurements also applied to the visual spectrum of the on-screen RTA. The IE-33 and IE-35 allow you to
choose whether or not the RTA display will show an unweighted display or a weighted display. To apply weighting filters to the RTA display, tap on the "Options" pop-up menu at the bottom of the screen and select "RTA
Weighting." Whatever weighting filter is selected for the SPL meter when in RTA mode (the SPL meter is in the
small windows in the lower right of the screen) will then be applied to the RTA display. Unchecking (by again
tapping) this selection will remove weighting from the RTA display.
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Pref. Curve, LED Display, Weighting

Entering a Preferred Curve Overlay
(Or how to draw a curve on your screen without using a grease pencil)

The Preferred Curve Overlay is a valuable aid to the equalization process. It is the electronic
equivalent of drawing a Preferred Cuve on the RTA screen with a grease pencil. The Preferred
Curve then provides you with an on-screen target equalization curve.
Step 1- Tap on Red "PE"
(Preferred Empty).

The Preferred Curve entry
screen will appear.

Step 2 - Use the Joystick
Left/Right to select a
frequency & Up/Down to set
the amplitude until curve
entry is complete.
Step 3 - Tap on the "PT"
button to display the
Preferred Curve Overlay.

Step 4 - The Preferred
Curve Overlay is now
displayed. To turn off the
display, tap on the green PT
button. To Edit the curve or
turn on the display tap on
the buff colored PT and then
the white PT button.

Selected frequency

Options

Options

Relative amplitude and
Frequency readout

Use the Memory button to Clear,
Store, & Load Preferred curves.

RTA LED Display
The RTA display can be set to an LED
style display using the "Function" menu

5 dB/div = 1 dB/LED

Options

Step 5- Tap on Memory
and store it for future use.

Applying SPL Weightings to the RTA Display
The SPL weighting filters "A" & "C" may be applied to the
RTA display by using the "Options" menu.

No Weighting

Weighting Applied

10 dB/div = 2 dB/LED
15 dB/div = 3 dB/LED

Options

Options

Options

Options
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Peak Hold Curves
The IE-33 and IE-35 will display peak information in addition to real time information in all of the display modes,
Octave through Maximum Resolution. The peak curve is shown in violet for the Octave, 1/3 Octave and 1/6
Octave displays, and in white for the Maximum Resolution display screen, as shown in the illustration across the
page. The peak curve data represents the highest levels that have been reached across the spectrum. In addition to peak data, real time information is also displayed.
To activate the Peak Hold function and display the peak hold curve, tap the pop-up “Options” menu and select
"Peak/Hold Curve." You can toggle through the various display formats (Octave to 1/3 Octave, etc.) while the
Peak Hold function is active. However, when selecting different display formats, the peak hold information will
not be preserved from display to display. Instead, it will initialize and begin again as though it had just been activated. To turn the Peak Hold function off, select "Peak/Hold Curve"" again. Note: If you store spectral data in
a scratch memory when the Peak Hold function is activated, real time data, not the peak curve, will be stored.

Frequency and Amplitude Detection
Several different modes of frequency and amplitude detection are provided by the IE-33 and IE-35. All of them,
including the Frequency Detect indicator, operate in all resolution settings, Octave, 1/3 Octave, 1/6 Octave,
Maximum Resolution and LF Zoom.
For real time data, a frequency detect cursor can be activated which constantly searches the spectra and displays the frequency of the highest level found in the spectrum. Real time data, or peak hold data, can also be
frozen using the "Stop" stylus button, and then be interrogated for frequency information using a provided cursor,
as demonstrated in the illustration across the page. The cursor can be moved using the stylus or the joy stick.
Additionally, any recalled and displayed memory can be interrogated for frequency information in the same
manner.
Frequency Detect: To activate the Frequency Detect mode (especially useful when searching for feedback frequencies), tap the “Options” pop-up menu and select "Freq. Detect." The Frequency Detect indicator will appear
on screen and begin to search for and identify the frequency registering the highest level. To turn off the
Frequency Detect indicator, select "Freq. Detect" again.
RTA Cursor: To activate the RTA Cursor, first tap the stylus button on the bottom left labeled "Stop." This will
"freeze" the RTA display and the bar below the SPL readout will change from green to red. Next, press the left
or right joy stick. The frequency cursor (a red + in Max. Res. or a green bar in Octave, 1/3 Octave or 1/6
Octave) will appear on the curve. The cursor can be moved left or right using the left and right controls of the
joy stick, or by using the stylus to tap, and thereby select, a new position. As it moves, frequency and amplitude
will be indicated in the SPL readout window and all areas of interest can be interrogated. To turn off the RTA
Frequency Cursor, tap the "Start" stylus button to return the analyzer to its real time display.
Peak Cursor: When the "Peak Hold Curve" is being displayed, peak hold data can be interrogated using the
Peak Cursor. To accomplish this, first turn on the Peak Hold Curve by selecting it from the ”Options” pop-up
menu. Next, tap the "Stop" stylus button. When the display has been stopped, select "Peak Cursor" from the
“Options” menu. The joy stick, or stylus, can then be used to move left or right along the spectrum to interrogate
the Peak Curve for frequency and amplitude information. Selecting "Peak Curve" again turns off this function.
Memory Cursor: This function works identically to the Peak Cursor. To activate the Memory Cursor, tap a
memory stylus button to recall the memory of interest. With the memory display on the IE-33, or IE-35 screen,
tap the “Options” pop-up window and select "Memory Cursor." The Memory Cursor will appear on the curve.
The cursor can be moved left or right along the curve by using the left and right controls of the joy stick, or the
stylus.. As it moves, frequency and amplitude will be indicated. To turn off the Memory Cursor, select "Memory
Cursor" from the “Options” menu again.
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RTA: Peak Curves, Freq. Detection

Peak Hold & RTA Curves

RTA Curve with Frequency
Detection display "On"

RTA Curve

Options

Options

There are many display options in
the "Max Res" mode. Along with
the RTA curve, the Peak Hold
curve can also be displayed.

Options

The "Frequency Detect" will
show the frequency of the FFT
Bin in which the highest
amplitude occurs. This is
extremely helpful when using a
parametric equalizer to EQ
feedback frequencies.

TO CLEAR THE "PEAK HOLD"
curve tap the "Clear Button."
RTA Cursor

DISPLAY of Cursor Frequency and
Level.
Options

To display the cursor, tap the
"Start/Stop" button to freeze the
display then use the Left/Right
Joystick to position the cursor.
Only the cursor selected in the
menu will be displayed. If the
Peak Cursor is not selected, the
RTA cursor will be shown.

RTA/Peak Hold Curves, Stopped RTA/Peak Hold Curves, Stopped
with Peak Hold Cursor diplayed. with RTA Cursor diplayed.

Options

Options

Options
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Memory Functions
The IE-33 and IE-35 memory systems provide all the tools necessary to save various types of files to memory,
rename files, load files from memory, examine memory data, and subtract one curve from another. Most memory system operations are performed using the memory stylus buttons and the memory management screen.
Memory Control Buttons: The memory stylus buttons are located immediately below the RTA display screen.
The row of twelve buttons allows both control of what is viewed on-screen, and the ability to store data in
"scratch memories." The far left "R" button toggles "on" or "off" the real time display. The "A" stylus button
controls the display of the Average curve. Stylus buttons 1 - 9 alternately store, remove from display, and
restore to display the contents of the nine Scratch memories. The "PE" stylus button controls "Preferred" or
"Target Curve" functions.
Stylus Button Colors: If a stylus button is red, there is nothing stored in the memory or display location associated with the button. If the button is green, there is data present and it is being displayed. Blue is identical to
green, that is, there is data present and it is being displayed. However, blue also indicates that this is the last
memory location to be manipulated. This blue color is very useful in keeping memories straight, especially when
using the thumb-push button instead of the stylus buttons to store data. Finally, if a button is buff colored, there
is data stored in that memory location, but not displayed on-screen (tapping a buff stylus button will display the
data associated with that button and change the button color to blue).
Scratch Memories: Scratch memories are "scratch pad-type" storage memories where you can temporarily
store curve data until you decide to rename and store the data permanently. You can store the RTA data you
are observing to a scratch memory by tapping a scratch memory stylus button, or you can depress the "thumb
button" on the side of the iPAQ, or the Axim. Using the thumb button is convenient and provides automatic,
sequential storage of data in scratch memories 1 through 9.
Memory Management: Tap the "Memory" stylus button to access the memory management screen. The memory management screen allows you to store, load, and clear files from scratch memories, Preferred Curve memory, subtraction memory, and peak memory. Select a memory location you wish to store and tap the adjacent
"Store" button. You will be prompted to provide a more descriptive name for the file you are about to store. You
can also change the location to which the file will be stored, if you wish. Tap "OK" and the contents of the
scratch memory will be stored under the name and in the location of your choice. To clear a scratch memory
with or without storing it, tap the adjacent "Clear" button. A stored curve data file may be loaded into a scratch
memory location by tapping the "Load" button, selecting the file to be loaded, and tapping on the file name.
Stored Peak and Subtraction data files may also be loaded into scratch memories.
Subtract Feature: The IE-33 and IE-35 provide a powerful function which allows the user to subtract one curve
from another. A stored scratch memory curve can be subtracted from the real time display, or one scratch memory curve can be subtracted from another, or from an Average curve. Tap the "Subtract" stylus button to access
the subtract control screen. From here, choose which spectrum you wish to subtract from another. Upon tapping "S1 - S2," the RTA display returns with a "0" center reference and yellow RTA bars. You are viewing the
one spectrum subtracted from the other. To return to normal RTA, tap the Subtract stylus button, then "Cancel."
Peak Storage: When displaying the "Peak Hold" curve in the RTA, you can open the Memory Manager and tap
"Store Peak" to store this peak information in the peak spectrum scratch area. From here you can rename it
and store it permanently. Stored peak curve data can be loaded into any of the nine scratch memories via the
Memory Manager. Just select a scratch memory and tap "Load." Next, select the peak memory to be loaded.
Memory File Format: Data stored in files can be moved to the PC using the standard Microsoft ActiveSync
software provided with the iPAQ or Axim. The analyzers always store data in full resolution of 2048 data points
across the spectrum. Using Ivie's supplied "IvieXLS" software and Microsoft Excel, you can display, manipulate,
and print data. The file format for stored data is a file header and four columns of ASCII text and number characters. The 4 columns are: 1: Hz (label), 2: Datum frequency, 3: dB (dB label), 4: Amplitude at that frequency.
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Store a curve to memory
Step 1 - Tap an empty Scratch
memory location 1 - 9 (colored in
Red). The curve will appear on the
screen and the Scratch memory
background color will turn Blue
indicating it is now filled and being
displayed.

Memory #3 being displayed

Buff colored 1, 2, 4 & 5 = Curves are
stored in these memories but they are
not currently being displayed.
Red colored 6, 7, 8 & 9 = These
Scratch memories are empty and
available for curve storage.

Tap the Blue Scratch memory to
remove the stored curve from the
display. The background color will
turn to Buff indicating that the
memory is filled but not presently
displayed.

Red "PE" Preferred curve not stored.
Blue = Scratch memory #3 displayed.
Red "A"= No Average curve is stored.
Green "R" = RTA curve is displayed.
Options

Step 2 - To store a Scratch memory to the
main memory, tap on the "Memory" control to
bring up the memory management screen.

Re-name a memory
from "Scratch" to a more
descriptive name and
tap on "OK."

From this screen you can "Store" a Scratch memory to
main memory or "Load" a memory from main back into
a Scratch memory. Preferred, Peak and Subtraction
memories can also be "Stored" and "Loaded."

Memory Cursor

Tap on a memory file to
move it into a Scratch
memory so it can
displayed.

Subtract / Display Two Memories

Step 1 - Tap on "Options" then "Memory
Cursor."
Step 2 - Tap on "Stop."
Step 3 - Turn RTA display On/Off as desired.
Step 4- Use Left/Right Cursor to select the
frequency.

Step 1 - Tap
on the yellow
"Subtract"
control.

Step 2 - Select two
sources or
spectrums for
comparison:
Options
Scratch Memory,
Preferred Curve,
Step 3 - The result will be displayed in
RTA Display or
dB
yellow on the screen. To exit this mode, tap
Freq Average and then on "Subtract" and then "CANCEL."
Tap "S1 - S2."
Options

Options
Options
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NIC Measurements
Sound transmission field testing of operable walls and field partitions is almost exclusively done using ASTM
E336 as the standard. The IE-33 and IE-35 are capable of making Noise Isolation Class (NIC) measurements.
NIC measurements are normally specified rather than Field Sound Transmission Class (F)STC measurements
because they are faster, easier, and therefore, less expensive to make. Field Sound Transmission Class
({F}STC) measurements require RT60 information for the calculation, as well as receiving room absorption in all
sixteen 1/3 octave bands of interest. Both the IE-33 and the IE-35 are capable of making RT60 measurements
(if the optional RT60 software module is purchased) as well as measuring receiving room absorption in the
required sixteen 1/3 octave bands. However, since RT60 measurement capability is an option, not a standard
feature, Ivie has chosen not to integrate (F)STC measurement measurement capability into the IE-33, or IE-35,
measurement suite. The following instructions are therefore limited to the theory of NIC measurements and
making NIC measurements.
NIC is a single-number acoustical rating of sound isolation between two different spaces separated by a sound
barrier. A typical measurement example would be determining the sound isolation provided by a wall or movable partition separating two rooms. To make the measurement, an omni-directional sound source would be
placed in the Source Room to energize it with pink noise. Averaged (power averaged), 1/3 octave RTA spectrum measurements would then be made on both sides of the wall (Source Room and Receiving Room) and
each room average would be stored to separate memory locations. The NIC calculation would begin as the
stored spectrum of the Receiving room is subtracted from the stored spectrum of the Source Room to create a
Transmission Loss (TL) curve.
The NIC rating would then be determined by comparing and shifting the TL curve relative to the standard NIC
contour such that the TL curve is never more than 8 dB below the NIC contour in any 1/3 octave band; and the
sum of the deficiencies below the contour over the 16, 1/3 bands, does not exceed 32 dB. Once the TL curve is
shifted to meet these criteria, the NIC rating is determined by the value of the NIC contour at 500 Hz. Once the
Source Room and Receiving Room curves are stored, the curve fitting and NIC calculation are all done automatically by the IE-33, or IE-35. Only a few taps of the stylus are required to complete the measurement and display the results.
The step-by-step process for making an NIC measurement is demonstrated by the illustrations on the opposite
page. Note: Of particular interest in NIC measurements is the requirement for power averaged data. The IE33 and IE-35 “default” operating mode is “Arithmetic Average,” so “Power Average” will need to be selected.

Real Time NIC Measurements
This is a very useful diagnostic tool offering, unique to Ivie instrumentation. This mode allows the user to compare the stored average curve in the Source Room to real time data in the Receive Room, thus providing a running calculation of NIC in real time. While in the Receive Room, the microphone can be moved to any position
around the sound barrier to find "sound leaks", weak isolation areas, strong isolation spots etc. Because the
NIC curve and calculated number are continuously updated in real time, it is easy to quickly compare different
areas, thereby determining deficiencies relative to location.
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How make an NIC measurment

Source Room

Receiving Room

Step 1- Under the "Function" menu select "RTA".

Measurement
Points @1 Meter
from the wall

Step 2- Make certain the Average mode is set to "Average-P"
(File>Preferences>Power Average).
Step 3- Turn on the sound source. In the Source room, go to a
position one meter away from the wall and press the "Average-P"
button. Move along the wall as samples are taken. Press the
"Pause" button when you reach the end of the wall.
Step 4- Store the Average to Memory #1 and then press the
"Count=" button to clear and reset the Average.

Omnidirectional
Sound Source
Store RTA averaged
spectrum in Memory #1

Store RTA averaged
spectrum in Memory #2

Step 5- In the Receiving room, go to a position one meter away from the wall and press the "Average-P" button. Move
along the wall as samples are taken. Press the "Pause" button when you reach the end of the wall.
Step 6- Store the Average to Memory #2 and then press the "Count=" button to clear and reset the Average.
Step 7- Press the "Subtract/STC" button to bring up the Subtract/STC screen.
Step 8 - In the "S1" column select 1(which is memory #1) . In the "S2" column select 2 (which is memory #2).
Now press the (F)STC/NIC(S1-S2) button.
Step 9 - To return to the RTA screen press the "Subtract/STC" button and then the "Cancel" button.

Step 1- Under the "Function" menu select "RTA"

Options

Options

Store 2 Measurements and
press the "Subtract/STC button

Select the two memories
and press this button

Display the NIC Curve
and Value

REAL TIME NIC or Sniffer Mode
The IE-33 can perfom "Real Time" NIC measurements. The real time spectrum measurement in the Receiver room is
subtracted from the spectrum of the Source room stored in memory #1. This mode is unique to Ivie. You can use it
as a "sniffer" to help locate leakage paths.
Step 1- Store real time spectrum in
memory #1.
Step 2 - Press the "Subtract/STC"
button.
Step 3 - Select memory #1 in the "S1"
column and "R" in the "S2" column.
Step 4 - Press the (F)STC/NIC(S1-S2) button.
Options
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Average Mode
The IE-33 and IE-35 Average Mode offer very powerful features that allow you to create continuous or triggered
averages of various types, as well as select the type of average that best suits your measurement.

Continuous Average Mode
In the RTA mode, tap on the “Average-A” stylus button. The default condition for the stylus button below the
Average button is “Cont.”, which indicates that you will be starting with a continuous average. When you tap the
Average-A button, the button text changes to “Count = X," where "X" is the number of samples so far collected.
You will see the sample number increment as the number of automatically collected data samples increases.
A blue line will immediately form on the RTA screen, which is the graphic representation of the average that is
being collected. The more samples collected, the slower this average display will change as short duration
acoustic events are encountered.
In Continuous Mode, the data sample collection can be paused by tapping Pause/Resume stylus button, or by
pressing the mechanical Thumb Button on the side of the iPAQ or Axim. Tapping the stylus button again, or
pressing the Thumb Button again, continues the sample taking process.
You may switch the screen presentation between 1/1, 1/3, 1/6 octave and Max Res at any time during an
Average measurement. However, doing so will reset the data sample counter to zero and start the averaging
process over again.

Triggered Average Mode
Tapping the “Cont.” stylus button will switch it to “Trigger.” In this mode, data samples for averaging are taken
only when the user manually triggers a sample. Triggering a sample can be done by tapping the “Add” stylus
button, or by using the mechanical Thumb Button on the side of the iPAQ or Axim. Each time a data sample is
added by triggering a sample, the sample count on the Average button will increment by one.
You can manually clear an Average Curve and reset the data sample counter to zero at any time by tapping the
“Clear” button. To exit the Average mode tap the “Count-X” stylus button.
Average Type Selection: The IE-33 and IE-35 Average Mode offer the power of two types of averaging. The
Arithmetic Average (Average-A) does straight arithmetic averaging. This type of average is probably best when
you are viewing the RTA screen while doing active equalization or other dynamic spectral adjustments. The
user may switch the averaging mode to “Power Average (Average-P), which is probably most useful in measurements where the total power is more important for measurements such as transmission loss, or noise isolation.
Switching from Average-A to Average-P is done by tapping the "File" pop-up menu. Select "Preferences" next,
and from that pop-up menu, select either Power Average or Arithmetic Average.
Viewing an Average Curve: While the average is being taken, the blue average line is seen in the RTA screen.
To see this line more clearly, you can temporarily remove the real-time data from the display. This is done by
tapping the green “R” button immediately below the RTA display (see figure on the opposite page). Don’t forget
to turn the real-time display back on when you’re done . . . It’ll save you a call to Ivie Tech Support!
Storing and Loading an Average Curve: When an Average Curve is displayed on the RTA screen, it is what
will be stored when you choose to store a curve. With this in mind, an Average Curve is stored in the same way
any other spectrum is stored. Simply select an empty scratch memory location (red stylus buttons indicate
empty memory locations) and tap it. The Memory Manager ("Memory" stylus button) allows the storing of any
scratch memory. Similarly, stored curves can be loaded into any standard scratch memory location by opening
the Memory Manager and selecting “Load” for any of the scratch memory locations.
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Continuous Mode

Tigger Mode
Step 1 - Select either the Continuous
(Cont.) or Trigger mode for
Averaging.
The Continuous mode will
automatically take sample after
sample until the "Pause/Resume"
control is pressed.
The Trigger mode will take only one
sample each time the "Add" control is
pressed or the Thumb button on the
side of the IE-33 is pressed.
Step 2 - Tap on the "Average-P"
control to enter into Average mode.

Options

Options

Step 3 - The "Average" display will be replaced with a "Count=X" display,
with X= the number of samples taken. In the Trigger mode the Count will
be incremented with each tap of the "Add" control. In the Continuous
mode the Count will be controlled by the "Pause/Resume" control.

To Select Averaging Method
1 - Tap "File."
2 - Tap "Preferences."
3 - Tap either "Power Average."
or "Arithmetic Average."

Step 4 - Store the Average curve by selecting any un-used scratch
memory. If you wish to store the real-time curve instead of the Average
curve, turn off the Average curve display before pressing the Scratch
Memory Store control.
Tap "Clear" to Clear the Average curve and reset the Count to zero.
Tap "Count" to Exit the Average mode.

Real time "R" and Average
"A" displays turned on.

Real time "R" display Off
Average "A" display turned on.
Average Curve

Green = Display On

Buff = Disp Off
Green = Disp On

Options

With Average
curve displayed,
press an empty
(red color) Scratch
Memory to store.

Options

Options
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Noise Criteria (NC) and Noise Rating (NR) Measurements
The IE-33 and IE-35 are equipped to make quick, accurate Noise Criteria (NC) and Noise Rating (NR) measurements. NC and NR are measurement protocols which allow the consultant or contractor to quantify the ambient,
or quiescent noise level of the room being measured. Many rooms that are designed by consultants are
designed to an NC or an NR specification, and NC/NR measurements are designed to confirm or certify that the
acoustic and mechanical design meet the required “level of quiet.”
Making an NC measurement with the IE-33, or IE-35, is very simple. From the RTA screen, tap on the “Options”
pop-up menu at the bottom of the screen. Then tap on “NC” to activate the NC measurement screen. The RTA
screen then automatically configures for NC measurements. You will note that the IE-33 and IE-35 switch to the
one-octave display and the RTA/SPL weighting revert to “Flat.” Both of these settings are required for NC measurements. You will also notice that the “NC Overlay Contours” are shown on the screen. These lines represent
the spectral contours that denote the various NC levels.
The NC contours can be “manually read” to determine the NC level. Making certain that there are no extraneous noise sources in the room (the room should be as quiet as it can be), activate the NC screen. Determine
the NC line that is closest to, but not touched by, the octave RTA display bars. This line represents the NC level
of the noise in the room or space being measured.
Note: NC levels are read in 5 dB increments. For example, there is technically no such thing as an NC 47.
Only NC 45 or NC 50. Many individuals, as a matter of practice, refer to NC numbers between the 5 dB levels,
and this can be useful, but it is not technically correct.
The IE-33 and IE-35 make the job easier. Instead of interpreting the movement of the octave bars, you can
observe the NC number which your unit calculates and displays in the lower-right SPL window. This number will
show the NC in dB increments, though the “official” measurements are in 5 dB increments. To make a “correct”
NC measurement using the NC numbers calculated by the IE-33, or IE-35, one need only round up to the nearest 5 dB increment.
Another Note: The maximum NC number in the NC protocol is NC 65. Any level above that does not fit in
the range of NC measurement. If the noise level of the space being measured is above NC 65, the calculated
NC number will display “NC++”.
NR Measurements are made in exactly the same way NC measurements are made, but the NR Overlay
Contours are slightly different. Neither NC nor NR is better than the other; they are just slightly differing standards. In various regions and countries, one is favored over the other. The consultant or contractor needs to be
able to measure to both standards in order to meet the needs of both specifications.
To activate the NR measurement screen, go to the “Options” pop-up menu and select “NR.” From that point, the
instructions for NC and NR are pretty much interchangeable.
NC & NR Averaging: It may be useful to use an averaged octave spectrum for making NC or NR measurements. To do this, activate the NC or NR screen, then tap the Average button. Activate the Continuous Average
button (see instructions for Averaging). The average function will begin taking samples and create a blue average spectrum line. When the Continuous Average function is active, NC and NR measurements are being calculated from the relationship of the average octave display (blue line) to the NC or NR Overlay Contours.
If you switch off averaging, the calculated NC or NR number will revert to making its calculations from the realtime octave bars.
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Making a Noise Criteria (NC) Measurement

Options

Options

Step 1 - While in the RTA
Function, under the "Options"
menu select "NC". Don't worry
about the RTA weighting as it will
automatically be set to "FLAT."

Step 2 - Read the NC value
in the SPL window.
Note: Any NC value over 65
will be displayed as NC++.

Options

Should you desire, you can
activate the averaging function and
then the NC will be calculated from
the Average curve.

Making a Noise Reduction (NR) Measurement

Options

Options

Step 1 - While in
the RTA Function,
under the "Options"
menu select "NR".
Don't worry about
the RTA weighting
as it will
automatically be set
to "FLAT."

Step 2 - Read the NR
value in the SPL window.
Note: Any NR value over
65 will be displayed as
NR++.

Options

Should you desire, you can
activate the averaging
function and then the NR will
be calculated from the
Average curve.

Options
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Sound Level Measurement
Introduction
The decibel (dB) scale has been adopted internationally for use with sound level meter testing. The scale
begins at a reference of 0 dB in sound pressure level (0 dB SPL) which corresponds to the smallest sound that
can be heard by a healthy human ear, and is equal to 2µN/m2, or perhaps more commonly, 20µPa. To get a
better idea of relative sound levels, consider the following: Quiet outdoors in the country would measure around
10dB, a very soft whisper about 30dB and average conversation around 70dB. An automobile horn would weigh
in at approximately 80dB, a jackhammer around 100dB and a small aircraft engine roughly 120dB. The threshold of pain is about 140dB.
When studying sound level measurements, it is of major importance to understand the response characteristics
of the human ear. Our ears do not respond equally to all the frequencies of the audio spectrum - in other words,
they are not "flat" in their response. To further complicate matters, the response characteristics of human ears
change with different SPL's. At relatively quiet SPL's, our ears attenuate high frequency sounds to some
degree, and drastically attenuate low frequency sounds. As SPL's increase, our ears get more efficient at low
frequencies and their response to sound becomes more "flat," although they never achieve a totally "flat"
response. Following is a set of curves which approximate the "A" and "C" curves, or the hearing response of
human ears. The "A" curve shows how ears hear, or perceive sound at low SPL's, while the "C" curve shows
how we hear at relatively high SPL's.
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These curves have been integrated into sound level meters for testing sound levels. "A" weighted (dBA) measurements use the "A" curve above, "C" weighted (dBC) use the "C" curve above, and "Flat" (dB SPL) measurements use no weighting at all.
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Make an SPL Measurement
Step 1 - Set the IE-33 for "Slow" response.
Step 2 - Set the IE-33 for "A" Weighting.
Step 3 - Read the SPL dB(A) in the SPL window.

Typically "A" Weighting is used because it approximates how humans perceive sound
The "Slow" Response is good for measuring sound levels of a continuous nature.

A

A

.

Sound Pressure Level in
dB SPL with "A"
Weighting Filter Applied.

Options

Tap to select different Weighting Filters to
be applied to the SPL Meter.
Tap to select different detector response
times for the SPL Meter.
In the "Peak Hold" mode the SPL meter
will capture and hold the highest SPL
reading. The "RESET" control must be
tapped to clear and reset the SPL display
for subsequent readings.
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Making SPL Measurements
An IE-33, or IE35, as shown on the opposite page, can make all the SPL measurements required by U.S. and
international standards, including A, C and unweighted SPL measurements. In addition to weighting, various
detectors, again specified by U.S. and international standard, can be selected for SPL measurement. These
detectors include Fast, Slow, Peak and Impulse. The Fast and Slow detectors are true RMS with different averaging times. Peak is a true peak detector, and quite fast. Impulse is a combination of an extremely fast peak
detector, followed by an RMS buffer and is intended for measurement of extremely short duration phenomena.
The Slow detector, in combination with A weighting, is normally used for making sound level measurements
related to noise associated with hearing damage. OSHA and other regulatory SPL measurements are normally
written around A weighted, Slow. It has been determined that high A weighted sound levels are more damaging
to human hearing than C or unweighted levels.
System Calibration for OSHA Measurements
OSHA measurements generally require equipment that meets minimum specification standards - at least an
ANSI Type II sound level meter, for example. The IE-33, or IE-35, with its supplied IE-33M, or IE-35M microphone, is a Type II sound level meter, and therefore satisfies OSHA minimum requirements. The electronics of
the IE-33 and IE-35 meet Type I specifications, however. With the addition of an optional Type I microphone
and preamplifier, both the IE-33 and the IE-35 become Type I measurement systems.
In addition to the equipment meeting minimum specification standards, it must also be properly calibrated in
order for an acceptable OSHA measurement to be made. What this normally requires is calibration prior to the
measurement, and then a recheck of calibration after the measurement is made. In the case of SPL measurements, a calibration device (either a pistonphone or an acoustic calibrator) must be used. The standard IE-33M
and IE-35M microphones are 8mm diameter, electret condenser microphones. Either can be calibrated with
any quality calibration device that will accept a 8mm adapter. Most calibrators have a larger diameter opening
to accommodate microphones up to one inch or slightly larger in diameter, and have plug-in adapters to reduce
the opening size for smaller microphones. The Ivie Type I microphones, along with many other international
standard air condenser microphones, are 1/2 inch in diameter and require the use of a 1/2 inch adapter when
calibrating. With either Ivie microphone, the same calibration process applies. It is important that the microphone fit snugly inside the adapter to assure accurate readings during calibration.
For complete information on calibration, see Appendix II of this manual dealing with this subject.

Sound Pressure Level (SPL) Monitor
The IE-33 and IE-35 normally display SPL readings in the lower-right corner of the display screen, as shown in
the illustration across the page. Immediately below the level readout, the weighting is displayed (A, C or Flat).
The detector selected is displayed on the blue colored stylus button in the center column of stylus buttons (Fast,
Slow, Peak or Impulse).
There are occasions when a much larger SPL display may be desirable. The "SPL Monitor" function provides
this. To access SPL Monitor, tap the "Function" pop-up menu and then tap "SPL Monitor" to activate this function. The large SPL display shown across the page will appear. The SPL at a resolution of 1dB will be displayed in very large, easy to see numbers. The smaller SPL readout in the lower-right of the screen will also
continue to function, providing its .1 dB resolution readout.
There is also a convenient bar graph display shown along with the large numerals. You can program this bar
graph to change colors at specific sound pressure levels. To do this, while in the SPL Monitor mode, tap the
"Options" pop-up menu and select Set dB Levels. The level for color change can then be set as shown in the
illustration across the page. The bar graph will change from green to yellow at the lower level programmed, and
from yellow to red at the upper level programmed. This feature can be extremely useful in some applications.
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Sound Pressure Level (SPL) Monitor

The large SPL display combined with a bar graph that changes colors at
user defineable set points facilitates SPL Monitoring of "live sound" events.
Set the controls to "Slow" and "A-Weighted."
TIP! - The iPAQ charging cradle can hold the IE-33, jacket and all. When
placed on a mixing console or desk top, the cradle holds the IE-33 at a
convenient viewing angle and can power the IE-33 and charge its batteries
at the same time.

Options

Options

Entering the Set points
1 -Tap "Options" and then "Set dB
Levels."
2- Set dB Lower set point.
3- Set dB Upper set point.
4- Tap the "ok."

Tap to select different Weighting Filters to
be applied to the SPL Meter.
Tap to select different detector response
times for the SPL Meter.

Options
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The large numeral SPL reading reflects the results of the detector selected (Fast, Slow, Peak or Impulse), and
the weighting selected (A weighted, C weighted or Flat). In addition, the SPL Monitor function provides level
monitoring in octave band levels. Technically, octave band readings are level measurements and not SPL
measurements, since SPL is, by definition, a broad band measurement.
Monitoring of octave band levels is possible in the following octaves: 125 Hz, 250 Hz, 500 Hz, 1 kHz, 2 kHz and
4 kHz. To select one of these octave centers, tap the green "Weighting" stylus button. It will toggle with successive taps from Flat to A weighted, to C weighted, to 125 Hz, 250 Hz , 500 Hz, 1 kHz, 2 kHz and 4 kHz, and back
again to Flat.

Sound Pressure Level (SPL) Seat-to-Seat
One of the highly useful functions of the IE-33 and IE-35 is the measurement of Seat-to-Seat variation. This
function can be used to measure the uniformity of sound level throughout a venue. The Seat-to-Seat function
allows you to set a reference level, which then becomes equated to 0 dB. As you move throughout the venue,
level in dB above or below the reference level is clearly indicated. As shown in the illustration across the page,
Seat-to-Seat variation is displayed in large numerals.
Additionally, there is a bar graph that displays Seat-to-Seat variation up to plus or minus 12 dB. There is also a
numeric readout which displays maximum deviation, the same data as the bar graph, except that it is not limited
to a range of plus or minus 12 dB. Of course, absolute SPL is also shown immediately above the maximum
deviation readout.
The large numeral SPL reading, as well as the bar graph and the maximum deviation readout, reflect the results
of the detector selected (Fast, Slow, Peak or Impulse), and the weighting selected (A weighted, C weighted or
Flat). In addition, just as in the SPL Monitor function, the Seat-to-Seat variation function provides level monitoring in octave band levels.
Monitoring of octave band levels is possible in the following octaves, as shown in the display across the page:
125 Hz, 250 Hz, 500 Hz, 1 kHz, 2 kHz and 4 kHz. To select one of these octave centers, tap the green
"Weighting" stylus button. It will toggle with successive taps from Flat to A weighted, to C weighted, to 125 Hz,
to 250 Hz, to 500 Hz, to 1 kHz, to 2 kHz, to 4 kHz and back again to Flat.

Making a Seat-to-Seat Measurement
To make a Seat-to-Seat deviation measurement, tap the "Function" pop-up menu and select "Seat-to-Seat."
Next, with steady-state noise playing in the venue, select a representative spot as the reference. Once a representative spot is located, establish it as the reference by carefully tapping the "Reset" stylus button. (This
"Reset" reference level will be remembered by the software even if Seat-to-Seat screen is left, but will not be
retained once the analyzer software program has been exited). Hint: Tapping the "Reset" stylus button roughly
will cause microphonic noise to travel through the unit (like tapping a microphone with your finger) which will elevate the noise level seen by the IE-33, or IE-35, thus setting a "false" reference level. Once the reference level
has been set, walking the venue will clearly indicate the level variation at various locations within the venue.
The type of venue will help determine the settings for the IE-33, or IE-35, when measuring Seat-to-Seat variation. The majority of venues will likely be measured in Slow response, as opposed to Fast or Peak. The bandwidth and weighting applied are more likely to change from venue to venue. If the system is intended for music
reinforcement, you may want to measure Seat-to-Seat in the Flat mode to assure full-range uniformity from
Seat-to-Seat. You may also wish to measure the same venue A weighted if there are concerns about it meeting
local noise or sound level ordinances, which will likely be written around A weighted measurements.
On the other hand, venues intended primarily for voice reinforcement may likely be "rolled off" on the high end
as well as the low end. It is not unusual to encounter Seat-to-Seat measurement specifications written around
band limited noise center at 4 kHz. Both the IE-33 and the IE-35 meet this requirement nicely.
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Sound Pressure Level: Seat-to-Seat

Step 1 - Set the IE-33 for "Slow" response and "2 kHz" filter weighting.
Step 2 - Energize the sound system with pink noise with the SPL in the room at least 10 dB
above the ambient noise.
Step 3 - Go to the first measurement position and press the "Reset" button to zero the meter to
that position.
Step 4 - Walk from seat to seat over the first coverage area and then note the Maximum and
Minimum SPLs measured. This measures the Seat-to-Seat variation for that area.
Step 5 - Go to the next area, press "Reset" and make a new measurement.
Graphic representaion of Min/Max and Current SPL deviation from zero. The
green box represents the Min/Max and the blue bars the Current deviation. This is
reset whenever the "Reset" button is pressed.

Real time, absolute value of SPL.
Maximum SPL (+) deviation from zero,
relative to the last time the "Reset" button
was pressed.
Minimum SPL (-) deviation from zero,
relative to the last time the "Reset" button
was pressed.
Current +/- SPL deviation from zero,
relative to the last time the "Reset" button
was pressed.
Pressing the "Reset" button clears all
Min/Max and Current data and sets them
to Zero at the moment of the button press.
From that moment forward, the Minimum,
Maximum and Current displays show the
+/- SPL relative to when the meter was
"Zeroed Out" (Reset button pressed).
Options

Tap to select different Weighting Filters to
be applied to the SPL Meter.
Tap to select different detector response
times for the SPL Meter.

Options
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Strip Chart
The Strip Chart feature of the IE-33 and IE-35 harks back to the days of pen on strip chart paper. We still find
this type of visual presentation to be one of the clearest and easiest to “digest” when looking at amplitude over
time. With Strip Chart, it is possible to record and review variations in amplitude over times ranging from one
minute to eight hours. Data collected in Strip Chart measurements can be viewed on-screen and/or on the PC,
or can be stored for later analysis.
To begin making a Strip Chart measurement, first select the desired weighting or filtering for the recording. Flat,
A, or C weighting may be selected. Additionally the measurement can be band limited to one of several octave
filters (125 Hz, 250 Hz, 500 Hz, 1 kHz, 2 kHz, or 4 kHz). This can be useful in crafting a measurement that will
be meaningful for the purpose intended.
Next, select the broadband SPL response detector. The standard Type I SPL detectors (Fast, Slow, Peak and
Impulse) can be selected. Impulse would rarely be used. Fast and Peak provide very useful data for analysis,
and Slow would be used for most environmental noise measurements, as many OSHA and other regulatory
measurements specify A weighted, Slow measurements.
The final set-up requirement for making a Strip Chart measurement is to select the length of the recording
desired. This is chosen by making a selection in “Chart Time” (Options> Chart Time). Additionally, you can set
visual minimum and maximum indicators with the Set dB Levels (Options > Set dB Levels) boxes. This gives a
visual indication when levels go above or below the levels you have set, and can be very useful locating "problem levels" at a glance. If you select a recording time longer than five minutes, it will be important to consult Tip #2 below.
In the "Options” pop up menu, you can also select the vertical display dB/division (this can also be done with the
left-most two mechanical buttons on the iPAQ or the Axim). The dB/Div and recording time are shown in the
upper left of the main display window.
Once all the selections are made, you can “drop the pen” onto the “paper” by tapping “Start.” It is possible to
stop the recording at any time by tapping “Stop.” At the end of the designated recording time it will automatically
stop and present a screen to name and store the recorded measurement.
Reviewing a recorded Strip Chart measurement is intuitive. Follow the directions on the opposing page.
Additionally, the following tips can be very helpful:

Tip #1:
In addition to using the software “slider” to page through the displayed data, you can also use the left-most two
iPAQ, or Axim buttons to page. Using the iPAQ, or Axim left/right rocker “joystick” you can walk the cursor to the
left or right on the chart. When you reach the edge of the screen, the cursor will “bump” to the next page and
reposition itself to the next pixel (it will appear to jump from one side of the screen to the other) on the chart.

Tip #2:
When recording a Strip Chart with a chart time of anything over 5 minutes, you may encounter the iPAQ, or
Axim power management limits. Setting the power management of an iPAQ, or Axim (under battery operation)
to maximum (Today Screen > Start > Settings > System > Power) you can operate the unit on battery for a
maximum of only about 5 minutes, without touching some kind of control, before it will turn off. Also, under
System > Settings > Back light, the maximum setting while battery powered is also five minutes. When making
a Strip Chart recording longer than 5 minutes you will want to arrange to power the unit from the charger.
Settings under power management while the unit is under charger power allow an iPAQ, or Axim, to
keep running with the screen lit indefinitely.
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dB per Division and Recording time
Step 1 - Select SPL
Weighting.
Step 2 - Select SPL
detector response.
Step 3 - Select Recording
time by tapping Options,
Chart Speed, and then the
recording time.

Recording Pen - Green in color when
the pen is down and writing/recording.
Red in color when pen is lifted and not
writing. Note: the pen is always
responding to the SPL even when not
writing.
Darkened areas are visual Min/Max
indicators set in the"Options/Set dB
Levels" menu.
Current SPL and Weighting.
Clears the current Recording
and resets time to zero.
Save Chart - stops the current Recording and saves
data to a File. Brings up a "File Save" screen.
Options

Options

Step 4 - Press the
"Start/Stop" button.

Viewing a Previously Recorded File

Minimum
data point.

Cursor controlled
by the Joystick or
by tapping on the
screen with the
stylus.

Maximum
data point.

Options

Completed 5 minute
Recording. Upon
completion, a Save to
File screen is
automatically
displayed.

To view a Saved Chart
press the "Load Chart"
button to display the
above screen, then
select the desired
Chart.
Data at
Cursor.

Press to unload file
and return to
recording screen.
Options

The Chart is displayed in an
expanded form so that each data
point is represented by one pixel.
The slide is used to "Page" through
the data one screen at a time.

Scroll through data including:
File name, Test date/time, Total
number of data points, Sample
interval, Weighting, Max SPL &
time, Min SPL & time.

Options
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Polarity
The Polarity feature of the IE-33 and IE-35 allow the user to test for the polarity of a loudspeaker with respect to
the signal source, or with respect to other loudspeakers.
Normally, in a correctly wired system, positive voltage on the “+” output of the signal source (amplifier) should
generate outward speaker cone travel (away from the speaker housing and magnet). More important to the perception of the listener is the uniform polarity wiring of all speakers in a system.
The IE-33, or IE-35, can help the user to quickly test for correct polarity. In order to test for polarity a pulse must
be generated and sent through the speakers to be tested. Both the IE-33 and IE-35 can generate the special
pulse needed to do the polarity test, though it may be desirable to generate the pulse external to these units
(see Tip #2 below). To generate the pulse from the IE-33, or the IE-35, connect the output (iPAQ, or Axim earphone output = 3.5 mm phone jack) to an input in signal processing chain going to the speaker system. From
the Polarity screen (Function > Polarity), tap the “Pulse On” button in the lower right of the screen. A special
pulse will begin to repeat.
In order to make a valid test, the IE-33, or IE-35 microphone should be in the direct field of the loudspeaker. As
you move the microphone close enough to a loudspeaker to be in the direct field, the Polarity display will show
“+” Positive Polarity, or “-” Negative Polarity, or “- - - “ No Lock. “Positive Polarity” means that the system is
wired so that the loudspeaker is correctly reproducing the output of the amplifier with regard to polarity.
“Negative Polarity” means the opposite. “No Lock” means that the microphone is either “confused” because it is
not in the direct field and is seeing too high a level of reverberant energy relative to the direct field, or the overall
level of the speakers is not sufficiently above the room’s noise floor. These conditions can be corrected by
either moving the microphone closer to the speaker or raising the output level of the loudspeaker.
The most important function of the Polarity test is to assure that multiple loudspeakers in a distributed speaker
system are wired so as to be of uniform polarity. By starting the pulse signal and then moving from the direct
field of one speaker to the next, the user can quickly confirm that the speakers are correctly wired for uniform
polarity. The following tips may also prove useful:

Tip #1
When speakers are mounted in a ceiling more than eight feet above the floor, it may not be possible to move the
microphone into the direct field of the speakers when the microphone is mounted to the IE-33, or IE-35 (unless
the user is on stilts!!). Using a microphone extension cable and a means of elevating the microphone closer to
the speakers can provide the solution (a broomstick and some tape works very well!).

Tip #2
Often, using the pulse generated by the IE-33, or IE-35, can be impractical since a long microphone extension
cable, or a long output cable, or both, might be called for in order to get the pulse signal into the sound system
while simultaneously moving the microphone close to the speakers. In most cases it is easier to use a separate
pulse source instead of the IE-33, or IE-35. There are several ways this can be done.
One way to do this would be to record the pulse and play it back to the sound system with a player. Another
would be to use the .wav file of the pulse provided on the CD that comes with both the IE-33 and the IE-35.
Yet another way would be to use an external generator that creates a pulse that is compatible with the Polarity
feature of the IE-33 and IE-35. The Neutrik® “Minirator”, for example, generates such a pulse.
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Making a Polarity Measurement
Step 1 - Connect the Polarity Pulse Generator output of the IE-33
(iPAQ headphone 3.5 mm stereo jack) to the line-level input of the
sound system. Note: The Neutrik Minirator MR1 generator provides
a compatible polarity generator signal.
Step 2 - Tap the "Pulse On" control to turn on the pulse generator
and set the output level of the speaker so that it is at least 10 dB
above the ambient noise.
Step 3 - Position the IE-33 microphone so that it is in close proximity
to the speaker under test. If you are too far away from the
loudspeaker the IE-33 may not be able to achieve a "lock" on the
polarity.
Step 4 - Read the polarity of the loudspeaker.

Options

The IE-33 is unable to achieve
a "lock" on the signal. Make
sure the output level of the
speaker is at least 10 dB over
ambient. Move the microphone
closer to the speaker.

Options

Options

The IE-33 has identifed the
polarity of the speaker as
"Positive."

Options

The IE-33 has identifed the
polarity of the speaker as
"Negative."
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Preferences Menu
The preferences menu (File>Preferences) provides access to a number of special selections and functions.
These are detailed below:

Diagnostics
Choosing Diagnostics provides a temporary setting (resets when the application is closed) that changes the
green/red box under the SPL window in the Main Display to show a numerical indication of the measurement
cycle time. The number represents the time required, in milliseconds, to complete a measurement cycle. The
Diagnostics setting is not normally displayed, but can help Technical Support Engineers to better support you if
you call the support center.

Power Average / Arithmetic Average
The IE-33 and the IE-35 will perform two types of averaging, depending on the type of measurement and preference of the user. The default setting is "Arithmetic". Power Averaging is most useful when doing transmission
loss and other such measurements where an average of power rather than level is required. The equations for
each are shown on page 33 across the page.

Oscilloscope (Scope)
The Oscilloscope Function provides a single or dual channel (dual trace, or XY) audio frequency (20 Hz to
20 kHz) oscilloscope. Page 33, across, contains illustrations regarding control details. The oscilloscope is useful in viewing wave forms of various signals. To use the oscilloscope function, the "Channel 1 (Line Level)" input
must be selected if a single channel oscilloscope measurement is desired. If a dual channel measurement is
required, the "Channel 1 & 2 Scope: XY/Dual Trace" inputs need to be selected. Input selection is done in the
following manner:

Input Select
The Input Select menu is located under the "File" pop-up menu. There are several inputs on the IE-33 and
IE-35 (a microphone connector and two RCA connectors). This selection area allows the user to select the
desired input or inputs. Remember that the IE-33 and IE-35 are two channel devices The microphone input
and Channel 1 line input are in parallel - both feed Channel 1.
The Channel 2 input is line level only.

Dual Trace or XY Measurements
When making dual channel measurements in the oscilloscope mode, either dual trace or XY measurements can
be selected using the "Options" pop-up menu.

Signal Generator
The IE-33 and IE-35 provide a simple signal generator. The output of the generator is available at the iPAQ, or
Axim, headphone jack, and the level of this signal is controlled by the audio level output control of the PDA (see
the iPAQ or Axim user instruction manual). Sine, Square, and Triangle wave forms can be selected, as can Pink
Noise and White Noise. The Main Display in this function shows the waveform of the selected signal type. See
page 33 across for software controls for the Signal Generator. In addition to the software slider, frequency can
also be selected with the iPAQ or Axim "joystick" left/right controls. Do NOT plug the output of the iPAQ, or
Axim into a mic input that has phantom power active. The phantom power will blow your PDA output.
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Preferences Menus
Displays an indicator, in milliseconds, of the time
required for a complete measurement cycle.
Choose one of two different Averaging algorithms
for the Averaging function.
Power Average =10 log

1
Arithmetic Average = N

N

10
10

i=1

SPL i
10

N

N

SPL i
i=1

Oscilloscope
Use the "File/Input Select" menu to select Line Level Inputs(s).
To use the Single Trace scope select either Channel 1 or 2 ,Line
Level input and connnect the Scope to that RCA input.
To use either the Dual Trace or XY function select the "Channel 1& 2"
Scope XY/Dual Trace Input. Use both RCA input connectors.
Tapping this control increases
the "sweep speed" causing the
waveform to expand on the
screen.

Single Trace

XY Display

Dual Trace

These controls allow
the vetical positioning
of the trace on the
screen.

With Ch 1&2 Input
selected the Options
menus allows
selection of Dual Trace
or XY.

Tapping this control to
switch other applicable
controls between Ch1
or Ch2.

Tapping this control decreases
the "sweep speed" causing the
waveform to contract on the
screen.
Decreases the input sensitivity
(vertical) causing the waveform
to dcrease vertically in
amplitude.
Increases the input sensitivity
(vertical) causing the waveform
to increase vertically in
amplitude.

Signal Generator
The output of the signal generator is the Headphone jack of the iPAQ.
The output level is controlled via iPAQ volume control.
Waveform display of selected signal source.
Display of frequency selected by the slider control.
The slider controls the output frequency of the Generator.
Tap to select the type of signal to be generated.

Waveform display controls,
same as oscilloscope.
Options

Options

Options
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Volt Meter
One of the most useful functions of the IE-33 and IE-35 is its ability to measure electrical signals as well as
acoustic signals. This can be extremely effective for trouble-shooting and system setup. As an example, pink
noise could be fed into the first component of a sound reinforcement signal chain. Using an IE-33, or IE-35 a
technician, or consultant could step through each of the sound system components. Levels at inputs and outputs could be measured, along with the frequency response at every stage. Crossover points and slopes could
be viewed, equalizer effects noted, level changes assessed and proper signal flow verified. A wealth of information would be available by simply probing the electrical inputs and outputs along the signal chain.
The IE-33 and IE-35 are capable of directly measuring preamp level voltages (not to exceed 7.5 volts).
Feeding voltages higher than 7.5 volts (+19 dBu) directly into an IE-33, or IE-35 could cause damage and
void the warranty. Higher voltages may be measured only with the addition of an external pad.

Volts RMS
When this mode is selected (see the illustration across the page for visual instructions on selecting various
measurement options), the IE-33, or IE-35, functions as a true RMS volt meter. Measured voltages are shown
simultaneously by a digital and an analog display.

Volts Peak to Peak (Volts PP)
In this mode, the IE-33 and IE-35 function as a peak voltage meters. Measured voltages are shown simultaneously by a digital and an analog display.

dB Volts (dBV)
When this mode is selected, the IE-33 and IE-35 function as a volt meters measuring in dB relative to 1 volt
RMS. Measured voltages are shown simultaneously by a digital and an analog display.

dB Volts Unterminated (dBu)
In this mode, the IE-33 and IE-35 function as volt meters measuring in dB relative to .775 volts RMS.
Measured voltages are shown simultaneously by a digital and an analog display.

Nixie Tube Readout
Using the "Options” menu, a more nostalgic Nixie tube digital display can be selected (see the illustration across
the page). Choosing the Nixie tube readout effects the digital display only. The analog display continues to
function without change.

Measuring Voltages and Viewing Spectral Information Simultaneously
When "Volt Meter" has been selected using the Function Pop-up Menu, only the voltage measuring displays
shown across the page are available. If measuring voltages and viewing spectral information at the same time
is desired, this is also possible.
To view spectral content and measure voltages simultaneously, keep the IE-33, or IE-35, in the spectrum analysis mode. Next, use the dB SPL readout box as a stylus button. Successively tapping this button will toggle the
IE-33, or IE-35, from dB (A, C, or F, depending on what has been selected) to Volts RMS, to Volts Peak to Peak,
to dB Volts, to dBu and back to dB SPL. The dB SPL readout now becomes the Volt Meter readout.
Of course, for this type of measurement, a line input for the IE-33, or IE-35, should be selected.
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CAUTION-Do NOT exceed input voltage of 7.5 Volts RMS AC (19 dBu)

Ch.1

Options

Step 1- Under the "Function"
menu select "Volt Meter"

Options

Step 2- Under the "File" menu select
"Input Select", then "Channel 1
(Line Level), then press "OK."

Options

Step 3- Connect to Ch.1
Line Input RCA connector

Options

Options

Step 4- Tap here to select desired display: Vrms, V peak to peak, dBV, or dBu.

V~ = AC volts RMS
V PP = AC Volts Peak-to-Peak
dBV = dB relative to 1 volt
dBu = dB relative to .775 volt
Options

Voltage or dB value
+++ = signal is overange
--- = signal is underange

A more nostalgic Nixie tube
readout may be selected via
the "Options" menu.

(F) = No weighting applied
(A) = "A" weighting applied to measurement
(C) = "C" weighting applied to measurement
Options

Indicates Ch.1/Line 1 input is selected

Options
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Simple Trouble-Shooting
One of the great advantages of the IE-33 and IE-35, is that they function as a software program on an iPAQ, or
Axim. When not running the IE-33, or IE-35 software, you have the bonus of having a standard PDA, with all its
inherent capabilities, software, data, time management and business management tools. The HP® iPAQ 3950,
3955, 5550, 5555 and the Dell® Axim X51v are all 64MB PDA’s. The IE-33 and IE-35 programs use under 300
kilobits of this memory capacity. That leaves a lot of capability for other programs, data etc.
The down side is, unless you’re careful, the other "stuff" you have in your PDA can affect the performance of the
analyzer software. Following are some tips that may help prevent down-graded IE-33, or IE-35 performance.

The IE-33, or IE-35 Display Appears to be Running in "Slow Motion"
Other applications running in the background can and will degrade the performance of the IE-33, or IE-35. If
your unit seems lethargic, it may be because it is having to share processing time with other applications. You
may have opened an application and not closed it (even the calendar or task list can slow things down a bit).
Closing applications in the Pocket PC environment is sometimes not intuitive. To check on this, close the analyzer software and go to the main "Today" screen of the iPAQ, or Axim. Tap "Start" in the upper left corner of the
screen. Now tap Settings > System > Memory > Running Programs. You will see a list of the applications that
are running in the background in your PDA. Tap "Stop All" to close all applications. Alternatively, you can select
individual applications and close them one at a time.
When you're done, tap "OK" in the upper right corner of the screen, then tap the "X" in the upper right corner to
return to the Today screen.
The "sure fire" way to shut down all applications is to do a "soft reset" by poking your stylus in the little hole in
the bottom of the iPAQ, or back of the Axim, designed for that purpose. Doing this will shut down all applications and give you a fresh start.

Exiting or Shutting Down Other PDA Applications
The convention for shutting down applications in Pocket PC is, well, not what you might expect. In Pocket PC,
the convenient little "X" in the upper right corner of the screen does not actually shut down the application; tapping the X will just put the application to "sleep" and keep it running in the background. There is no indication
on the iPAQ, or Axim standard display that there are applications "asleep" in the background.
In order to shut down a standard application one must go to the "File" menu of the application and tap "Quit" or
"Exit."
Ivie has chosen not to follow the Pocket PC convention. When you are in the IE-33, or IE-35 software, tapping
on the X WILL shut down the application.

My IE-33 Data, Applications, Measurements - Gone! All Gone!
There is a major warning at the beginning of this manual concerning data loss. We repeat this warning here, so
its unhappy effects may be avoided. The iPAQ will continue to discharge when sitting on the shelf in the
"Off" position. If the battery runs down, everything in volatile memory will be lost - data, software - everything!
It is wise to keep the IPAQ charged, and prudent to store in the iPAQ's non-volatile memory anything that must
not be subject to loss. You have the choice of whether to store something in volatile or non-volatile memory, but
you may not have enough non-volatile memory available to store everything there you would like to store.
The Axim (IE-35) features “Retentive Memory” and is not subject to this problem when the battery runs down.
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Calibration procedure for the IE-33

Notes on calibration:
1. Whichever microphone(s) is employed, it is calibrated to the Ivie IE-33 Jacket (IE-33J) and not to the
iPAQ Pocket PC. The iPAQ simply remembers and applies the calibration value of the Microphone/IE33J combination to the calculations of IE-33 SPL measurements. Calibration requires that the
Microphone, Jacket, and iPAQ be kept together as a complete instrument. You will need to recalibrate
the instrument if any of the above items are changed.
2. The IE-33J and its accompanying IE-33M microphone have been calibrated to each other at the
factory. A factory Certificate of Calibration is included with each IE-33J/Microphone combination. If you
purchased a complete IE-33 including an iPAQ, the calibration number has been entered into your iPAQ
and you DO NOT NEED to complete the initial calibration procedure below. If you have supplied your
own iPAQ, YOU MUST follow the Initial Calibration Procedure below.
3. Periodic Calibration may be performed in the field if you own an SPL Calibrator. The procedure for
this is listed below.

INITIAL CALIBRATION
(Without Calibrator)

Step 1 - Remove the iPAQ from the
IE-33J jacket. The iPAQ must not be
connected to the IE-33J in any way.
Step 2 - Press "File/Input Select"
Menu.
Step 3 - Make sure the Mic to be
calibrated is selected.
The iPAQ can remember the calibration
values for up to six different microphones.
Press the "Calibrate" button to enter the
calibration screen.
Step 4 - Using the Up/Down buttons,
enter the calibration value from the
supplied "Certificate of Calibration" into
the "Calibrator dB SPL" window
and press the "Calibrate" button.
Step 5 - Press the "Done" button.
Step 6 - Press the "OK" button to
accept the calibration.
Step 7 - Place the iPAQ into the IE-33J
and you are now ready to use the
Calibrated SPL functions of the IE-33.

PERIODIC CALIBRATION
(With Calibrator)

Step 1 - With the iPAQ inserted into the IE-33J,
enter into the Calibration mode by selecting the
"File/Input Select" Menu.
Step 2 - Select which microphone you are
going to calibrate to the IE-33J. The iPAQ
can remember the calibration values for up
to six different microphones.
Step 3 - Place the Calibrator (user
supplied) over the microphone to be
calibrated. The IE-33 SPL meter is
automatically set to FAST response and
FLAT weighting. The current dB SPL being
measured by the IE-33 will be displayed in
real time in the ’Current dB SPL" window.
Step 4 - Using the Up/Down buttons, enter
the desired calibration level into the
"Calibrator dB SPL" window. This would
include any allowances for altitude and
barometric pressure should your
calibration equipment provide these.
Step 5 - Press the "Calibrate" button.
Step 6 - Press the "Done" button.
Step 7 - Press the "OK" button to
accept the calibration.

Calibration Constant - For factory calibration, the CC value should match
the CC value on your Factory Calibration Certificate. If you perform your
own calibration the number may change, and should be recorded for future
reference.
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IE-33J Jacket & IE-35 PAL: Data and Program Transfer
If you have purchased the IE-33J, or IE-35 PAL (jackets without PDA’s), you will need to install the IE-33, or IE-35 software
on your PDA in order to use the jacket and make measurements. Even if you have a complete IE-33, or IE-35 package, you
will need to install software upgrades and updates as they become available. Also, after measurement sessions you may
wish to bring IE-33, or IE-35, data files across from the PDA to your PC for printing or further data manipulation.
All data and program transfers between the IE-33 iPAQ, or IE-35 Axim and your PC are done using Microsoft's ActiveSync
software. ActiveSync is provided on the standard CD that accompanies your PDA. Follow the instructions provided with
your PDA to install the ActiveSync software and create a "partnership" between your PDA and your PC. Questions about the
ActiveSync communication between your iPAQ, or your Axim, and your PC are supported by HP® or Dell®. Note: The
iPAQ requires ActiveSync Version 3.7.1, or later, while the Axim requires ActiveSync Version 4.0, or later.
Assuming that you have Microsoft ActiveSync installed and running on our PC, and that you can successfully synchronize
your iPAQ, or your Axim, with your PC, let's talk about moving data and programs between these devices.

Installing IE-33, or IE-35, Software or Software Updates
Put your IE-33 iPAQ, or your IE-35 Axim, in the sync cradle (or attach the sync cable) and make sure synchronization communication is taking place. (As with many things in Windows, there is more than one way to skin a cat. We're just showing
you one reliable way to do it here.)
Open Windows Explorer and browse to the location of the Ivie "IE-33.exe" (or “IE-35.exe”) file. This may be on your hard
drive if you downloaded an update, or on the CD that comes with the IE-33J or IE-35 PAL. Now, right click on "IE-33.exe" (or
“IE-35..exe”) and select "copy." Now browse to My Computer, Mobile Device, My Pocket PC, iPAQ File Store (for iPAQ), or
Build-in Storage (for Axim). Right click on iPAQ File Store (for iPAQ), or Built-in Storage (for Axim) and select "copy."
You have now successfully copied the file necessary to run the IE-35 on you Axim, or have copied the IE-33 software into
the iPAQ File Store area of your iPAQ. The iPAQ File Store area in the 3900 and 5500 series iPAQ is a non-volatile storage
area. Even if your batteries are completely drained, the IE-33 program file will be safely stored in non-volatile memory.
Now that the IE-33 software is installed on your iPAQ, or the IE-35 software on you Axim, remove the PDA from the
ActiveSync cradle or cable and turn it on. Tap "Start" in the upper left corner of the screen. Tap "Programs." Select "File
Explorer" by tapping on the icon. The "root" of the iPAQ file system is "My Device." Navigate to "iPAQ File Store." You
should see the IE-33 software"exe" file. Tap and hold the stylus on the IE-33 file. Tapping and holding will bring up a menu.
Tap on "Copy." You have now copied the IE-33 software to the iPAQ's clipboard. These same instructions apply to the
IE-35, except the IE-35 software will be located in “Built-in Storage” on your Axim.
Next, navigate back to "My Device," then tap on "Windows," then on "Start Menu." In the white screen area, tap and hold the
stylus until a menu pops up. Now tap on "Paste Shortcut." You have copied a shortcut for the IE-33, or IE-35, program file
into the Windows Start Menu. Each time you turn on your PDA and tap on the "Start" button in the upper left corner of the
screen, you should see the choice for IE-33, or IE-35, on the main screen.

Data Storage on the iPAQ
The IE-33 default directory for storing files is "My Documents." Virtually all of the Main Memory storage is available if you
store to this directory. However, this memory area is volatile, so if the batteries totally discharge you will lose the stored data
files. If you routinely charge the iPAQ this will never be a problem. However, if you have data files you wish to be secure in
non-volatile memory, you can use the Memory Management screen (described elsewhere in this manual) to select "iPAQ File
Store" as the target location for data storage. Any files stored in iPAQ File Store will be preserved in non-volatile memory.
The IE-35 files are stored under “My Documents” as well, but “Retentive Memory” prevents data loss from battery discharge.

Transferring Data
Data files stored on your PDA can be accessed by your PC under the “Mobile Device” directory. Using Windows Explorer,
browse to My Computer, Mobile Device. There you will find the stored data files. Most data files have the extension ".ivi".
Standard "Scratch" files have the default label "Scratch," followed by the number of the scratch file location. Preferred Curve
files use the label "Preferred," and Peak files use the term "Peak." Strip Chart data files use the default label "Chart."
However, the user can name these files to any name when saving them, or rename them at any time. The ".ivi" file extension must be maintained or an IE-33, or IE-35, will not be able to read the files.
Select the data files you wish to transfer by holding down the ALT key and left clicking on the desired files, (the normal
Windows conventions for selecting files apply). Once the files are selected, right click on any of the selected files and choose
"copy." Now browse to the location on your computer's hard drive where you wish to locate the data files (usually in the
"IvieXLS" directory), right click on the chosen directory, and choose "paste." The selected files will be transferred to your PC.
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Switchcraft
TA4F

Connect to
Ivie IE-33J

1
2
3
4

Shield

Audio (+)
Audio (-)
+Vdc

Switchcraft
TA4M

1
2
3
4

Connect to
Ivie IE-33M
Measurement
Microphone

Schematic for Ivie Part# 33MC-25 Extension Cable

Switchcraft
TA4F

Connect to
Ivie IE-33J

1
2
3
4

Shield

Audio (+)
Audio (-)
+Vdc

Switchcraft
A6M

1
2
3
4
5
6

NC

Connect to
Ivie IE-2P
with 1/2 inch
Microphone
Capsule

NC

NC

Schematic for Ivie Part# 2PMC-25 Extension Cable

Switchcraft
TA4F

Connect to
Ivie IE-33J

1
2
3
4

Shield

Audio (+)
Audio (-)
+Vdc

Switchcraft
A3F

1
2
3

Connect to
Standard
Low-Z Dynamic
Microphone

No Connection

Schematic for IE-33J to Dynamic Microphone Cable
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IE-33 Software Loss
As described in Appendix I, page 36, the IE-33 software and measurement data can be lost if the unit becomes
fully discharged. Since the iPAQ does have some non-volatile memory available for use, the IE-33 software can
be stored as a CAB File in the non-volatile memory for easy installation, should the software ever get lost.
The following instructions explain how this can be done:

IE-33 CAB File Installation and Use Instructions
In the past, when the IE-33 software became lost, it was possible to easily restore it using the "setup".exe file
through the ActiveSync utility on your PC. The latest IE-33 software has always been available for down load
from our web site, www.ivie.com. While this process has been and continues to be available for use, there is
now a second way to restore your IE-33 software.
Beginning with version 5.8.2, when you run the IE-33 Setup.exe file, a file named "IE33-Setup-v5.8.2ARM.CAB"
will be created in file/directory on your PC from which you began the installation.
Via ActiveSync, you can copy this file to the "iPAQ File Store" folder on your IE-33 iPAQ. The iPAQ File Store
folder is a non-volatile folder. Even if your iPAQ batteries are run down completely "flat," anything in the iPAQ
File Store folder will remain in the iPAQ.
By going to the iPAQ File Store folder and "double tapping" on the "IE33-Setup-v5.8.2ARM.CAB" file, the IE-33
software will be installed from this non-volatile area into the folder from which the IE-33 application needs to
operate.
Thus, by keeping a copy of the "CAB" file in the non-volatile iPAQ File Store area of your iPAQ, you can have an
"emergency install" ready and in place, even if you find yourself in the field, away from a PC, when you have a
need to reinstall.
Special Note: The act of double tapping on the CAB file will cause the IE-33 application software to be
installed, but it will also erase the CAB file. If you want to have a permanent CAB file as an emergency install
backup at all times, do this:
Using the File Explorer in your iPAQ, or using File Explorer on your PC via ActiveSync, go the iPAQ File Store
folder. Create a sub folder titled "Backup". Put a copy of the IE-33 CAB file in the iPAQ File Store/Backup
folder. Now, if you ever need to do an emergency install, simply make a copy of the CAB file into the iPAQ File
Store folder, run it (double tap on it) from there. The CAB file you run will be erased as the install takes place,
but the copy in the iPAQ File Store/Backup folder will remain.
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Ivie XLS Instructions
The IvieXLS software provided with the Ivie IE-33 and Ivie IE-35 is actually a template for the Microsoft® Excel®
spreadsheet program. IvieXLS will function properly with versions of Microsoft Excel versions 2000 or newer.
(For purposes of brevity in this instruction set, the IE-33 and the IE-35 will be referred to as IE-33/35, since both
function identically with IvieXLS software).

Before You Start the Software
Before using IvieXLS, you will need to transfer the data files of interest that were measured with the IE-33/35 to
your PC. This can be done using the standard Microsoft ActiveSync® software and connecting cables supplied
with the PDA by which virtually all synchronization of files is done. Please refer to the instructions with your
PDA on how to transfer files.
Once the files of interest have been transferred to your PC, you are ready to begin using the IvieXLS software.
Ivie RTA files have the file extension, “.ivi”. Ivie Strip Chart files have the file extension “.cha”.

Starting IvieXLS
When you are ready to start using IvieXLS, do not start the Microsoft Excel application! Instead, you need to
start the IvieXLS template. The template is the file installed to your computer when you install IvieXLS. That file
is named something like “IvieXLS ver. x.x.xls”. When you start the IvieXLS template, it will automatically start
Microsoft Excel. Note: If Excel is running when you start IvieXLS, the Ivie charting application will not run properly. You MUST begin your session by starting IvieXLS.
Upon starting up the IvieXLS application, a “permission screen” will pop up which will allow you to “enable
macros.” You will need to enable macros in order for IvieXLS to operate properly. If you don't see the enable
macros screen during startup of IvieXLS, check the security settings in Excel. You may need to alter your security settings.
Once IvieXLS starts, two windows will appear. The left window is the main chart screen, on which you will find
the graphic depiction of your data. The right screen is a narrower control screen from which you will be able to
set up the display in the main window.

Control Panel
Most of what you need to know to operate IvieXLS deals with the right-hand control panel shown on the next
page. Let's examine the control panel, from top to bottom. When we're done with the control panel, you will
know most of what you need to know to begin the next step of experimenting with the IvieXLS application itself.
The upper-most panel on the control screen allows you to input the “Current Job Name.” IvieXLS will remember that name from session to session and you can change it as needed. The job name is the description you
will choose for the particular measurement, or series of measurements you are making. It can describe the
measurement itself, or the venue where the measurement is being made, or whatever you want to see on the
chart when you print it out.
The “Edit” panel under Current Job Name is for entering your company information. The information you put
here will be remembered from session to session, and will print on any of the forms that you print using IvieXLS.
The next panel down is “Data Sets.” This is the panel you will use to select the “.ivi” or “.cha” files you wish to
display. The examples we will use in this instruction set will deal with “.ivi” files, as they are by far the most
commonly used.
“Data sets” are just that. When you bring a file over from your IE-33/35, it consists of ASCII, alpha numerical
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Use to enter or edit
current job name.

Use to enter or edit your
company name.

Up to ten different data
sets may be imported.

Use to select data file for import
from IE-33 or IE-35 to your PC.

Use to select
display resolution.
Use to average two or more
displayed curves together.

Use to select type of
plot desired.

Use to subtract one curve
from another.

Use to "overlay," or match one
cuve to another.

Use to select plot scale.

Use to select plot center level.

Use to show NC or NR
overlays.
Use to add identifying
notes to a data set.

Use to weight a plotted curve.
Use to print a displayed plot.
Use to save a data set.

Use to display the
data numerically.
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data that numerically represents all of the data recorded in that measurement. As you'll see a little later in this
document, you can view the raw data as well as the graphical representations thereof.
As you see from the Data Sets panel, you can select up to ten data sets (or curves) to display in the main data
screen at one time. While having ten curves displayed at one time can, in some cases, be convenient, most
times there would be too much “going on” in the display screen, if you were showing ten curves. Most users will
find either a single curve, or perhaps two, three, or four curves about right. Nevertheless, experiment and see
what makes sense for your application.
To select a data file, click on the “Select Data File” button near the bottom of the Data Sets panel. You will be
presented with a screen that facilitates file selection. In order to select the first file, click on the “1" button. You
will be presented with a file navigation screen which will allow you to navigate through your PC's file folders to
find the files you have transported from your PDA to your PC. Select the file of your choice.
As IvieXLS works to create the display of your file, be patient. IvieXLS is processing 2048 data bins and allocating them into the proper position for the display. This can take a few seconds.
Once you've selected the first file you want to view, you can repeat the process to add other files to be viewed
on the same screen.
Note that you can clear individual files from the control panel, replace files, add additional files, etc.
When you are done selecting files, click on the “OK” button to come back to the main control panel.
One of the first things you will want to do is select the display resolution of your data. With the four buttons
immediately below the Data Sets panel, you will be able to select display resolutions of 1/1 octave, 1/3 octave,
1/6 octave, or Max. Res*”.
Note 1: The data brought across from your PDA to your PC is “raw” data, consisting of 2048 data points. The
IvieXLS template then processes the data for display in the user selectable resolutions. You can, therefore, look
at any curve. In ANY resolution, even though the curve may have been stored in the 1/1 octave mode. It was
not 1/1 octave data that was actually stored by the IE-33/35, but all 2048 data points. This stored data, then,
can then be viewed in any of the available resolutions, either on the IE-33/35, or on your PC using IvieXLS..
Note 2: “Max Res” allocates the 2048 data points in the file for “maximum resolution.” In a practical sense, this
means that the information above 125 Hz is displayed in about 1/24 octave resolution, while information below
125 Hz is displayed in ever wider bandwidth equivalents as you go lower in frequency. IvieXLS does not currently support displays recorded using Low Frequency Zoom on your IE-33/35.
Once you have selected the resolution of the display (which you can go back and change at any time), you can
select how you want to plot the information. “RTA Line” or “RTA Bar” selects how the information will be presented to you; in a line graph or a bar graph. Depending on the resolution you want, and the purpose for which you
are creating the chart, select the type of display that best suits your needs.
You will note that there is a check box labeled “Average.” If you have more than one curve on-screen, by checking Average, you can average the curves together to display one averaged curve. Uncheck the box and you will
go back to the individual displays.
By clicking on the “Delta” button, you are presented with a control screen that allows you to select any two of the
curves you have on-screen (you must have at least two curves on-screen for this feature to be useful) and subtract one from the other. Just follow steps 1, 2, and 3 on the Delta control panel, then click on the “Plot” button
and you will see the result in the main display area.
Once the Delta curve is displayed, you can still change resolution, bar/line, scaling, etc. When you have the look
you want, you can tap “Print Chart” and print out what is displayed in the main screen.
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When you are done with the Delta display, simply tap the “Return to Control Panel” button to return to the main
control panel and the main display. Wait a sec!!! I've done that (you say) and the Delta display is still there.
How can I get back to the regular display? You can't! (Just kidding) Simply tap any one of the resolution control
buttons on the main control panel and you will be back to the main display.

Curve Matching
Let's talk about “Curve Matching.” In the course of making measurements in the field you may end up recording
curves of the same source that were measured at different distances from that source. Later, you may wish to
put these similar measurements on-screen together to see how they compare (to determine HF loss with distance, or perhaps uniformity of coverage from one location to another, etc.). But when you do so, there may be
a level difference due to the different distances at which the curves were recorded.
Curve Matching allows you to vertically move one curve with respect to the other on the screen so as to more
closely overlay one on the other.
To use Curve matching you must have at least two curves on-screen. Then click on the Curve Matching button.
You will be presented with a Curve Matching control panel. It is similar to the Delta control panel. Just follow
steps one and two in order to select the curve you want to be the Master Curve (the one that doesn't move and
becomes the master for the other[s]), and to select the “Curve to Adjust”.
Step three allows you to adjust the one curve relative to the other. Select Major or Minor adjustment (adjusts
the amount of movement per click of the up/down arrows) and then use the arrows to move the “Curve to
Adjust” up or down to lay it over or “match” the Master Curve.
Tap the “Return to Control Panel” button to return to the main control panel. Tap any of the resolution buttons to
remove the curve matching and return to the main display.

dB Scale
One of the adjustments you will want to experiment with is “dB Scale” selection. The dB Scale adjustment
allows you to change between 5, 10, and 15 dB per division on the amplitude display of the main screen.
Depending on what you want to see (details or trends, for example) in your display, you can adjust the dB Scale.
In the same area of the main control panel you will find “dB Center.” This allows you to move the displayed
curves vertically on the screen by changing the dB value of the horizontal center line of the main screen display.

NC and NR Displays
NC and NR gives you the ability to display NC (Noise Criteria) or NR (Noise Rating) overlays on-screen. Read
the IE-33/35 manual (page 18) for more information on NC and NR measurements.

A and C Weighting
The A Weight and C Weight selection boxes apply A or C weighting to the displayed curve(s). Sometimes you
may wish to view the curve with weighting applied.

Add Text Label
The “Add Text Label” button brings up a sub control panel which allows you to create a text label and position it
on the main display. This can be used to make special notes about particular characteristics of a curve, or just
apply a general note on the main screen for printing or display. The note, or notes can be saved to the XLS file
for future reference.
Note that the “Add Text Label” function is just a simplified way of creating and adding notes. If one is familiar
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with Microsoft Excel, the normal Excel methods of adding and locating notes, etc., can be employed.

Strip Chart
The “Strip Chart” function in IvieXLS is used to display the special “.cha” files that are created when using the
Strip Chart function of the IE-33/35. Tapping the Strip Chart button presents the special control panel for this
function.
Use the Select Data File button to open the navigation screen in order to find the “.cha” strip chart file you want
to display. Select the file and you will view its presentation in the main display window.
Using the “Edit” button in the Strip Chart control panel, you can, if you wish, attach a job name to the display
chart.
Using the Zoom Level control in the Strip Chart control panel, you can choose how many data points you want
to view per page, and how many pages or screens you want to use to divide up the display.
Use the “Screens Control” to move from one screen to the next. (The left and right PC keyboard arrows will
also page from screen to screen. As you are looking at the screen, you will notice a time reference at the bottom of the screen and amplitude reference on the left vertical axis of the screen.
You can also use the “Add Text Label” control to put text notes on the screen to annotate certain events or areas
of interest.

Printing, Saving, Viewing Numerical Data
Finally, you can print the chart or save it with your annotations for later review. Click on “Return to Control
Panel” to come back to the main control panel.

Print Chart
“Print Chart” takes you automatically to the print function of your Widows based PC. Your main display screen
will print.

Save As
“Save As” takes you to a standard Windows screen that will allow you to save your work to a file in the location
of your choice on your hard drive.

Table of Levels
The “Table of Levels” function presents on-screen, the actual numerical data that is used to build the graphic displays for different resolutions. This is not the “raw” data, but rather the amplitude data for each of the octave
band resolutions: 1/1, 1/3, 1/6. In some instances, it can be useful to view the numerical data. Table of Levels
allows you to do this.
At this point, you should have most everything you need to begin navigating the IvieXLS application. It will take
some experimentation and practice to determine the best way to format, display and print the data for your specific requirements.
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